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1 Document Information

1.1 Purpose and Scope

This document provides a step by step description on how to integrate Endress+Hauser PROFIBUS devices
with the Schneider Electric Modicon M580 system. All content of this document is jointly developed,
reviewed and approved by Schneider Electric and Endress+Hauser as a common deliverable of Open
Integration.

1.2 Document History

This is version 1.00.00 of this document. Version history:

Version Released Description

1.00.00 2015-12 Initial version

1.3 Related Documents

Please refer to related documents as listed below:

Document Description

SD01462S/04/EN/01.15 | Reference Topology SEO1

SD01464S/04/EN/01.15 | Integration Test Summary SEO1

SD01465S/04/EN/01.15 | List of Tested Devices and Versions SEO1
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2 Pre-Requisites

Readers of this document should be familiar with related documents as listed in chapter 1.3 and basics on
how to work with the Schneider Electric Modicon M580 System and PROFIBUS in general. Please refer to
recommended literature as listed in chapter O.

2.1 Recommended Literature

2.1.1 Schneider Electric

Document Description

EI00000001854.02 Modicon M580 Remote I/0 Modules (Hardware)
35006238.12 Modicon M580 and Premium/Atrium using Unity Pro
S1A64489.02 Profibus Remote Master User Manual

2.1.2 Endress+Hauser

Document Description
BA00065S FieldCare Project Tutorial
BA00070S Fieldgate SFG500 Installation and Commissioning

2.1.3 Other

2.1.3.1 Pepperl+Fuchs

Document Description

tdoct0835g_eng.pdf POWERHUB Segment Coupler Manual

2.2 Operable Control System

This document assumes an operable Schneider Electric Modicon M580 System as defined by Reference
Topology SEO1. Please refer to the manuals listed in chapter 2.1.1 for an explanation on how to use hard-
and software provided by Schneider Electric.

2.3 Operable Asset Management System

This document assumes an operable Endress+Hauser PAM System as defined by Reference Topology
SEO1. Please refer to manuals listed in chapter 2.1.2 for installing of hardware and software provided by
Endress+Hauser.

SD01463S/04/EN/01.15 5/96
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2.4 Operable Field Network Infrastructure

This document assumes an operable PROFIBUS DP / PA field network infrastructure as defined by
Reference Topology SEO1. Please refer to manuals listed in chapter 2.1.3 for installing of hardware and
software provided by other parties.

2.5 Operable Field Devices

This document assumes an operable selection of Endress+Hauser PROFIBUS DP and PROFIBUS PA devices
connected via the field network infrastructure, as defined by Reference Topology SEO1. Each field device is
adequately powered and prepared with unique tag and PROFIBUS address. If required, please refer to
individual device manuals for further advice.

SD01463S/04/EN/01.15 6/96
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3 Basic Integration

This chapter describes the main workflow for integration of a PROFIBUS network and field devices into the
Schneider Electric Modicon M580 system by means of GSD. As a result, the cyclic PROFIBUS
communication is running and process values with status information are available within the control
strategy of the system for further processing.

3.1 System Configuration

3.1.1 New project

e Start the software Unity Pro XL.

B

Unity Pro XL

e (reate a new project with the menu “File> New...".

Unity Pro XL
[File View Tools PLC Help

B) New... Ctrl+M
ﬁgpen... Ctrl+0
Exit

e Select the PLC and Rack type.
In this example, the PLC BME P58 2040 is mounted on a Rack BME XBP 0800.

New Project
[] Show all versions
PLC Min0S Version  Description Cancel
Modicon M340
" Mordoon MEED -
BE P58 1020 o110 CPU 580-1 ETH distribued 10
~ EBMEP582020 01.10 CFU 580-2 ETH distributed 10
_ BMEPS330X CPU 5803 ETH ditriouted 10
ME P58 3040 CPU 580-3 ETH remete and distiibuted 10
ME P58 4020 CPU 5804 ETH distributed 10
ME P58 4040 CPU 5804 ETH remete and distibuted 10
& Momentum Uity
[ Premum
Guantum
Rack Description B
" Modicon M580 local drop | [
£ Rack =
BME XBP 0400 4 5LOTS BACKPLANE
BME XBF 0800 £ 5LOTS BACKPLANE b
BME XBF 1200 12 SLOTS BACKPLANE
BMX XBP 0400 4£5LOTS BACKPLANE ,
Froject Settings
[] Settings File: <default settings>

SD01463S/04/EN/01.15 7/96
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e Created Project structure.
File Edit View Services Tools Build PLC Debug Window Help

a=d B E @ &% S
.----me

Pm}ect Browser

%a Structural view

....... W= Project|

B @ Configuration
........... %R’ 0:PLC bus

........... m 0 : BME XBP 0400

e B, ) (P) : BMx CPS 2000
-8, 0(1) : BME P58 2040

4

3.1.2 Modicon M580 hardware configuration

3.1.2.1 PLCRack
e Double-click on the field “0: PLC bus” in the Project Browser view.
Project Browser

%a Structural view

....... a" Project
5 ........... @’ Configuration
-,

The PLC module is inserted automatically with the power supply CPS2000.

g |BME P58.2040 01.10 -

il

Bus: |

In our example, the Power Supply module CPS2010 is used.

O
Delete the current one by right-clicking on the symbol CPS2000 and select the menu

“Delete Module”.

SD01463S/04/EN/01.15 8/96
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] B3 8 .
i o Cut Ctrl+ X
il
Qop}r Ctrl+C
@_ Cirl+
Delete Maodule Del
Power Supply Budget...

o The power supply module is now deleted.

o Double-click on the empty module and select the correct power supply module. In this
case, it is the module BMX CPS 2010.

MNew Device @
Topological Address: 0.
Part Mumber Description
£ Modicon M580 local drop |

=1 Supply |
-~ BMXCPS 2000 | STANDARD AC POWER SUPPLY
[ BIVX CPS 2010 | STANDARD 1SOL DC POWER SUPPLY

-~ BMXCPS 3020 HIGH POWER 1SOL 24 TO 48 VDC POWER SUPFLY
;- BMXCPS 3500 HIGH POWER AC POWER SUFPLY
~~ BMXCPS 3540 HIGH POWER DC POWER SUPPLY

o PLCrack configuration.

3.1.2.2 PLCIP address

e Inthe Project Browser, double-click on the field “EIO".
Project Browser =l
%a Structural view

i, Project
- {3, Configuration

. B3R, 0:PLCbus

¢ B, 0:BME XBP 0400

(F) (F) : BMX CPS 2010

0 (1) : BME P58 2040

L)

SD01463S/04/EN/01.15 9/96
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¢ Following window is displayed.

RIO DI0 Communicator Head

L] CommreadRioDiOE 1T Security | T ooty | [} As7P | 0 swwe | 10 w7P | 10 ServicePor
B Channel 0 4 L 1 ]
™.
™
e
[ Enforce scanty | [ Unlock Seauity

Autharized addresses

IP Address
192168101

S
DD

Subnet mask -
255.255.00 3

Zizgzzzz e
T FFEEFEE pIE

e (lick on the button “Unlock Security”. This enables the FTP/ TFTP / HTTP options.
{0 Security | T iPconiy | T A57P | T s | 10 7P | (T Servicerar |

FIP:  [Enabled -

TFTP : [Enabled -

HTTP :  [Enabled -

Access Control : [Disabled v]

Enforce Security Unlock Security

o Select the Tag “IPConfig”.
Configure the IP addresses according to the connected network.
In this example:
o The main PLCIP address is 10.126.105.30
o ThePLCIP address Ais 10.126.105.31
o The subnet maskis 255.255.252.0
o The default gateway IP address is 10.126.104.1

SD01463S/04/EN/01.15 10/96
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{0 Secumy | {00 1PConiig | T 2577 | {0 s | 10 7P | (T Servicerar |

IF addres= configuration

Main [P address 10 . 126, 105. 30
IF address & 0. 126, 105, 3

IF addres= B 0. 0. 0.0 [Used for Hot Standbey]
Subnetwark mazk 265. 286, 262. 0
Giateway addresz 0. we

CRA P address configuration

Drop N Device Name IF Address o~

e Save the configuration by clicking on the symbol “Validate” in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

e~ ]

3.1.2.3 PLCDTM

e C(lick on the menu Tools=>DTM Browser in the Tool bar.
File Edit Wiew Ser\.rices[Tools Build PLC Debug Window Help

a=E s | 2= 4| + Project Browser Alt+1 5
2 M E |§l i | Hardware Catalog Alt+2
s | [@ Types Library Browser Alt+3
Operator Screen Library Alt+4 F
%a Structural view
Search / Replace Alt+5 —
@« Configuration Diagnostic Viewer Alt+6
PLC Screen Alt+7
Variable Window Alt+8
Data Editor Alt+9
DTM Browser Alt+Shift+1
Bookmarks Alt+Shift+2

e The DTM Browser displays already the configured PLC IP address, 10.126.105.30 in this example.
Double-click on the DTM “BMEP58 ECPU".

DTM Browser
E < 10.125.105.30 > EMEPS8_ECPU

#f, Remote Bus
----- %, Distributed Bus

¢ Following window is displayed.

SD01463S/04/EN/01.15 11/96



Schneider

Endress+Hauser £71]

People for Process Automation

Integration Tutorial SEO1

Source Address:

Source IP Address:

Sub-Metwork Mask:

EtherMet/TF Network Detection:

Begin detection range address:

End detection range address:

Modbus Metwork Detection:

Begin detection range address:

End detection range address:

Version 1.00.00

10.126.106.208 hd

205 .20G GRZoEa

10 .12 . 104 . 1

o . 126 . 107 . 254

w0 .16 . 104 . 1

10 .12 . 107 . 254

e Check the source IP address (IP address of the engineering station).

e Re-adjust the Ethernet/IP Network Detection and Modbus Network Detection Range addresses
according to the network configuration.

EtherMNet/IP Network Detection:

Begin detection range address:

End detection range address:

Modbus Metwork Detection:

Begin detection range address:

End detection range address:

7

N

o . 126 . 105 . 28

0 .12 .15 . 33

0 . 126 . 105 . 28

w ., 126 . 105 . 3

e (lick on the button “Apply” to validate the changes.

QK ] l Cancel

]

|

Apply

e Confirm the Message Box by clicking on the button “Yes".

Modification Authorization 3

l-\ Do you confirm the modification 7

[ ves ][ Mo

SD01463S/04/EN/01.15

12/96



Schnelder Endress+Hauser (21

E lectric People for Process Automation

Integration Tutorial SEO1 Version 1.00.00
3.1.3 Modicon X80 hardware configuration
3.1.3.1 170 platform Rack

e Double-click on the field “2: EIO bus” in the Project Browser view.
I'jlnj‘ec'lnﬁmwser

%a Structural view

------- @, Project
-3, Configuration
5@, 0:PLC bus
]]IU, 0 : BME XBP 0400
B, ) (P : BMX CPS 2010
T, 0 (0 : BME PSB 2040

e This opens the following window. Double-click on the white square.

Bus:

e Select following parameters according to the SEO1 topology architecture:
o The topological address 1
o The Rack BME XBP 0400
o The EIO Drop adapter BME CRA 312 10.2

CommHeadRIODIOE 01.00 - Connections configured: 0 |

New Device
:
Topological Address:  [1..8] 1
Part Number Description Help
" Modicon M580 remote drop |
& Rack
BME XBP 0800 85LOTS BACKPLANE
E XBF 1200 2 5L0TS BACKPLANE
X XBF 0400 LOTS BACKPLA
X XBF 0600 LOTS BACKFLA
X XBF 0200 LOTS BACKPLA
X XBF 1200 2 5LOTS BACKPLANE

=[]
BMx CRA 312 00.2
BMx CRA& 31210.2

SD01463S/04/EN/01.15 13/96
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Inserted EIO Drop adapter BME CRA 312 10.2

L]
Bus | 2 CommHesdRIODIOE 01.00 Connections configured: 1
1
e Double-click on the 1* empty slot to insert the power supply CPS2010.

New Device @
T
'

Topological Addiess:

Part Number Description
5 Modicon M580 remote drop
B Supply | — S
+ BMX.CPS 2000 STANDARD AC POWER SUPPLY

[l BMX CPS 2010 | STANDARD ISOL DC POWER SUPPLY
" BXCPS 3020 | HIGH POWER ISOL 24 T0 48 VDC POVIER SUPFLY
- BXCPS 3500 [ HIGH POWER AC POWER SUPPLY_

BMX CPS 3540 _| HIGH POWER DC POWER SUPPLY

e 1/0 platform rack.

o

3.1.3.2 1/0 platform EIO adapter IP address

A default IP address is automatically set for the EIO adapter BME CRA 312 10.2 according to the PLC and

network configuration.

Click on the tag “Parameters” to display the EIO adapter IP address.

L]
#B0 performance EID adapter
I overiew | | Device ooT | ) RSTP | [B) SMtP | [P SenicePor | [f) P | ' TimeStamping

Address information

Dlevice Mame : EMECRA_D01 Tens: I o Ones: 1 ¥

IP Address : 0 . 126 . 105 . 32

S 265 . 285 . 2. 0

Hold up time

Hold up time : 1000 = ms

Connection parameter

5 . Application trigger
CR#& -» Scanner RF : Soanner - CRA BRI
MAST: B2 ms E2 ms
e If needed, the EIO adapter IP address can be changed.

14/96
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In the Project Browser view, double-click on the field “EIO” of the menu “0: PLC Bus".

Project Browser

%a Structural view

-3, Project
a, Configuration
Bl 0+ PLC bus
7l 0 : BME XBP 0400
o T, (F) (F) 2 BMX CPS 2010
-, 0 (1) : BME P58 2040

o The EIO adapter IP address is inserted in the part “CRA IP address configuration”.

{0 Secumy | {00 1PConiig | T 2577 | {0 swwe | 10 7P | (T Servicerar |

IF addres= configuration

Main [P address 10 . 126, 105. 30
IP address A 0. 126, 05, H

IF addres= B 0. 0. 0.0 [Used for Hot Standbey)
Subnetwark mazk 265. 2686 262. 0
Giateway address 0 . 126. 104, 1

CRA P address configuration

Drop N°f  Device Name IP Address
1 BMECHA_0m 10.126.106.32

o Double-click on the IP address.
CRA IF address configuration

Drop N Device Name : IP Address
1 EMECRA_001

o Change the IP address to the requested one.
CRA IF address configuration

Drop N Device Name IP Address
1 EMECRA_001 10.126.106.25

o Save the configuration by clicking on the symbol “Validate" in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

3 4

g = & sy =] &

Es G Validate h

For the next steps, the EIO adapter IP address is set to the IP address 10.126.105.32.

SD01463S/04/EN/01.15
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3.1.3.3 170 platform EIO adapter device name
[}

In the Project Browser, double-click on the field “0 : BME CRA 312 10.2".
Project Browser

%a Structural view

a, Configuration
%m, 0:PLChus

= 2 : EIQ Bus

t}-v 1: Modicon M580 remote drop

- [[lll, © : BME ¥BP 0400

----- (P} (P) : BMX CPS 2010
Bo

e Configure the device name to the requested one with the fields “Ten” and “Ones".
In this example, device name is BMECRA_001.
™ overview | % Device ooT | [ RSTP | [ Swmp | [ Senvicerort | [ Parameters | [ TimeStamping |
Addresz information
Device Mame : EMECRA_00 Teire p o Ones: 1 =
IF Address: o . 128 . 08 . 32
U=t 265 . 285 . 252 . 0
L]

Set this device name on the EIO adapter thanks to the rotary switches.

In this example, the address is set to 1 for the device name BMECRA_001.
0 ,,Clear

1610, 2¢° 50,5
HORTO}
SRy

& (]
/8 \ g\
LTens pevice Ones

Save the configuration by clicking on the symbol “Validate” in the tool bar.
File Edit Wiew Services Tools Build PLC Debug Window Help

a=H
&

L2

Bx|e

3.1.4 DRS switch configuration

Connect the engineering station directly to the DRS switch

Start the software Ethernet Switch Configurator.

SD01463S/04/EN/01.15

Version 1.00.00
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e The function “scan” is automatically started.
Connected devices are displayed in the window. The connected DRS switch can be identified with
the MAC address which is written on the device. If the DRS switch was never configured, the IP
address is 0.0.0.0.

e Select the MAC address field and click on the menu “Properties”.
In this example, the MAC address is 00:80:63:F2:82:0E.

"""'.-Q.‘__Ethernet Switch Configurator
File Edit Options 7

¥

Signal

&

Properties

2

i vy

Telnet

Id MAC Address Writable

1|00:580:63:F2:52:0E

e Configure the DRS switch IP address according to the connected network.
In this example:
o DRS switch IP address is 10.126.105.28
o Net Mask address is 255.255.252.0

o Default Gateway is 10.126.104.1

"% Ethernet Switch Configurator -0 x|
File Edit ©Options 7

v | & 2| W |9 @ %

Signal | Properties | W | Telnet | Ping | Rescan | Preferences
Id MAC Address ‘Writable I IP Address A I Met Mask. I Default Gateway | Product I Mame

S | x|

MaC Address: 00:30:63:F2:82:0E

Mame: |TCSESMOB3F23FL

~IP Configuration

IP Address: (10 .Jiz .Jws .[&  Setoefakoom |

Met Mask: EENERERRE Set Default (0.0,0,00 |

Defaulk Gateway: | 10 .| 126 .| 104 .| 1 Set Default {0.0,0,0) |
Save As Defaulk |

Ok | Zancel |

o (Click on the button “Ok” to save the settings.
o |IP settings have been updated.

SD01463S/04/EN/01.15 17/96
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“ay Ethernet Switch Configurator =10 x|
File Edit Options 7
9 4 2 8 | 9| @ %
Signal | Properties: | WA | Telnet | Ping | Rescan | Preferences
Id MAC Address Writable IP Address & Default Gakeway Product Mame

hek Mask,
10.126,105.258 2 2

1/00:80:63:F2:82:0 ﬂ

3.1.5 PRM Gateway configuration

3.1.5.1 DTM library

10.126.104.1

23F1 |TCSES

The installation of the DTM “Gateway DTM V1.2" is required in order to configure the PRM Gateway. This
library can be found on the PROFIBUS Remote Master CD-ROM.

e Once the Gateway DTM Library installed, the new components can be displayed in the DTM

catalog.
Click on the menu “Tools>Hardware Catalog”.

File Edit Wiew Services | Tools| Build PLC Debug Window Help

2 | « Project Browser Alt+1

HamBA | |-

e Select the Tag “DTM catalog” and click at on the button “Update” to display the new installed

components.
Hardware Catalog

i | Hardware Cataleg Alt+2 F

& {0*" devices Device Vendor

@ Devicetyes |8 ALTIVARTI Revison...|  Device Schneider Bectic | 27 |

b= Vendors B ALTI Device Schneider Electric 33
b= Groups q BME AHI 0812 Gateway Schneider Electric 10430 | 20140523
& Frotocols [ BMEAHD 0412 Gateway Schneider Electic | 1.0.49.0 | 20140523
i BMENOCD301 Communication Schneider Electric 1.5.13.0 20141118

E_ _ BMENOCO301 ffrom ... Device Schneider Electric 11
| & BMEMNOCD311 Communication Schneider Electric 15130 | 20141118

._BI'!IEI\I_OEQJH ffrom .. Device Schneider Electric 11

E_EMEPEBWZD ffrom E Device Schneider Electric 13

[ oo

4] 4] #]¥\ ElOBuUs A PLCbus }, DTM catalog /

e Following Message Box is displayed.
Click on the button “Yes".
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| Uni‘ly.l-’ln.')(L |_EI§_|
@ The DTM Catalog seems to be up of date\Would you like to update it?
[ Yes ] [ Mo
¢ Installed components
ig FRM Comm Communication Schneider Electric 1x
L] PREM Gateway Gateway Schneider Electric 1.2 201402-26
ig PRM Master Communication Schneider Electric 1x

3.1.5.2 DTM Browser project structure

3.1.5.2.1 PRM Gateway DTM

Click on the menu “Tools>DTM Browser” in the Tool bar.

|
o

.
File Edit Wiew Services ITooIs Build PLC Debug Window Help
e | Bz ¥ | ¥ Project Browser Alt+1
.‘-,51 1all=] |§k = | Hardware Catalog Alt+2
EE— [ Types Library Erowser Alt+3
Operator Screen Library Alt+4
%a Structural view
Search / Replace Alt+5
{3, Configuration Diagnostic Viewer Alt+6
i PLC Screen Alt+7
Variable Window Alt+8
Data Editor Alt+9
DTM Browser Alt+5hift+1
Bookmarks Alt+5hift+2
e The DTM Browser displays already the configured PLC IP address.
DTM Browser . .
=
=--§5% < 10.126.105.30 > BMEP58_ECPU
l"@ Remote Bus
5, Distributed Bus
e Right-click on the PLC and click on the menu “Add".
DTM Browser
{3y Host PC
=8
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e Select the PRM Gateway and add it to the DTM Browser project structure by clicking on the button

“Add DTM".
Add
Device Type Vendor Wersion Date -
E BMEP584020 from EDS) Device Schneider Electric 13
E BMEP584040 from EDS) Device Schneider Electric 13 |j
E BMX NOC04017 from EDS) Device Schneider Electric 1.1
E BMX NOCO401 Revision ... Device Schneider Blectric 21
E BMX NOC0402 from EDS) Device Schneider Electric 1.1
E ETE 1EI 0BE 085 PPO ffro... Device Schneider Blectric KX
E ETE 1El 12E 045 PPO ffro... Device Schneider Blectric KX
E ETB 1El 16C PO from E. .. Device Schneider Electric 36
E ETE 1El 16E FPPO from E... Device Schneider Electric 36
=] Genenc Device Device Schneider Blectic | 1.1.17.0
E Generic Device Bxplict Msg Device Schneider Bectric | 1.1.17.0
E Lexium 32 from EDS) Device Schneider Electric 1.1
E Modbus Device Device Schneider Bectric | 1.1.10.0 | 2011-04-27
‘1 PRM Gateway Schneider Hectric 3 2014-02-26
E Schneider TCSESMO4X0... Device Schneider Blectric 1.1
E Schneider TCSESMO4X.. Device Schneider Blectric 12
E Schneider TCSESMOGX... Device Schneider Blectric 12
E Schneider TCSESMO3X0... Device Schneider Blectric 1.1
B Schneider TCSESMORY Nevices Schneider Flertrir 11 2

e C(lick on the button “OK".
Properties of device ==

General |Dem'c.eir|forrnatior1 I DTM information | Protocol information

DTM name management

Alias name :

Tag name :

Default 1/0 vision management

Default input 110 vision
Variable name : PRM_Gateway_IN

Default output 1/0 vision
Variable name : PRM_Gateway_OUT

e The PRM Gateway is now part of the DTM browser project structure.

DTM Browser

{3 Host PC

=88 < 10.125.105.30 > BMEPS8_ECPU
-5, Remote Bus

-5y, Distributed Bus
x I

B8 ] < Modbus: 10,126, 105.33 > PRM_Gateway
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e Double-click on the PRM Gateway DTM.

This corresponds to the menu “Offline Parameter”.
DTM Browser

{30 Host PC

B- [E < 10.125.105.30 > BMEP58_ECPU
----- %, Remote Bus
% Distributed Bus
L,@ < Modbus: 10. 126, 105. 33 > PRM_Gateway

Version 1.00.00

e The PRM Gateway MAC address must be configured. This address is written on the PRM Gateway.

g [ G Schneider
i Profibus Remote Master Configuration Toal L Electric
=] PRM Master Configuration -
... General Settings Factory IP Address
- Profibus Master Configuration Factory IP Address is derived from the MAC Address printed on the PRM label
..o Basic Settings
ﬁ Advanced Settings Factory IP Address:
.= 10 Scanning MAC Address: 0 80 F4 FF 0 0 0 .10 0 . 1
This IP Address will be used if the PRM Gateway DTM cannot connect to the PRM via the
dedicated IP Address.
Dedicated IP Address
Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be also stored in the
PRM configuration file
IP Address:
10 .126 . 105 . 33
Subnet Mask: =
255 255 252 o
Default gateway:
10 . 126 . 105 . 30
DHCP/FOR Server
Parameters of this section need to be filled if you want to use a DHCP/FDR server.
Create an entry for this device name in the DHCP server.
Device Name
TCSEGPAZ3F14F 000 Extension[000..159](rotary switches value)
D Backup the PRM configuration in FOR server on downioad. 1
ok | [ conce Aoply Help
<Il= Disconnected [0 Dataset
EElPRM_Gaten..
e Enter the MAC address :
In this example, the MAC address is 00:80:F4:FF:2C:29.
Factory IP Address
Factory IP Address is derived from the MAC Address printed on the PRM label.
f Factory IP Address:
MALC Address: D || &0 || F4 || FF || 2C Zﬂ 0 .10 . 44 1

This IP Address will be used if the PRM Gateway DT cannot connect to the PRM via the
dedicated IP Address.
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e (lick on the button “Apply” to validate the changes.

oK ] ’ Cancel ] ’ Apply I [ Help

3.1.5.2.3 PRM Gateway IP address

e Adefault IP address is automatically set for the PRM Gateway according to the PLC and network
configuration.
This IP address cannot be edited in this menu.

R FRM Gateway 3 A
, chneider
LI Profibus Remote Master Corfiguration Tool Electric

=5 PRM Master Configuration

[ 4 General Settings| Factory IP Address

(@ Profibus Master Configuration Factory IP Address is derived from the MAC Address printed on the PRM label.

& Basic Settings
& Advanced Settings
= 10 Scanning MAC Address: 0 || 80 || F4 | FF| 2c| 22 10 .10 . 44 . &

Factory IP Address:

This IP Address will be used if the PRM Gateway DTM cannot connect to the PRM via the
dedicated IP Address.
Dedicated IP Address

Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be also stored in the
PRM cenfiguration file

IP Address:
10 . 126 . 105

m

Subnet Mask:

Default gateway:
10 . 126 . 105 . 30

DHCPFOR: Server
Parameters of this section need to be filled if you want to use a DHCP/FDR server.
Create an entry for this device name in the DHCP server.

Device Name

TCSEGPAZIF14F 000 Extension[000..159](rotary switches value)

D Backup the PRM configuration in FDR server on download.

oK | [ concd Apply Help

l= Disconnected 0 Dataset

-EFHM_Gatew...l

e The PRM Gateway IP address can be edited by opening the PLC DTM.

In the DTM Browser view, double-click on the DTM “BMEP58_ECPU".
DTM Browser

{33 HostPC
(=8 17 < 10.126. 105.30 > BMEP58_ECFU
b2y, Remote Bus
E| P'@ Distributed Bus

------ L@ « Modbus: 10. 126, 105.33 > PRM_Gateway
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¢ Inthe device list, select the PRM Gateway.

BMEPS58_ECPU
li' Communication
BME P58 2040

Channel Properties
L. TCRaP
Services
fo Address Server
EtherMet/IP Local Slaves
E| Local Slavel
Items

Local Slave 2
Items
Local Slave 3
- tems
=~  Device List
: [001] BMECRA_00L <EIP: 10.126.105.32>
- Exclusive Owner
s [036] PRM_Gateway <MDB: 10.126.105.33>
Logging

e Select the Tag “Address Setting”.
- Address Setting | Request Setting

1P Configuration

IP Address: 100 p19sc. 105 C08E
Subnet Mask: 255 . 255 . 252 . 0
Gateway: 0 . 126 . 105 . 30

e Enter the new IP address and click on the keyboard button “Enter”.
Address Setting | Request Setting

IP Configuration

IP Address: # W .12, 105. 34
Subnet Mask: 255 . 255 . 252 . ©
Gateway: 0 . 126 . 105 . 30

e Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

e Asa consequence:

o The DTM Browser project structure is automatically updated.
DTM Browser

{30 Host PC

=88 < 10.126.105.30 > BMERS8_ECFU
l"@ Remote Bus

-3, Distributed Bus

B8 < Modbus: 10.126. 105.34 > PRM_Gateway
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o The IP address in the PRM Master Configuration is automatically updated.
Dedicated IP Address

Dedicated IP Address will be the primary Address used to connect to the PRM. This Address will be alzo stored in the
PRM configuration file

IP Address:
10 . 126 . 105 . 34

Subnet Mask:

255 . 255 .252 . @
Default gateway:

10 . 126 . 105 . 30

For the next steps, the PRM Gateway IP address is set to the IP address 10.126.105.33.

3.1.5.3 PRM Gateway working mode

The PRM Gateway can be configured either with DHCP mode for dynamic IP assignment or Store mode for
fixed IP address. The mode must be selected on the PRM Gateway by using the rotary switches and
configured accordingly in the DTM browser of Unity Pro.

3.1.5.3.1 Clear IP steps
This step is needed to delete the PRM configuration file.

e Shut down the PRM Gateway power supply.

e Disconnect the PRM Gateway Ethernet cable.

e Remove the PRM Gateway from its backplane.

e Set the address 0 for the upper rotary switch and E for the lower rotary switch.

¢ Mount the PRM Gateway on its backplane.
e Energize the PRM Gateway.
e The PRM Gateway LED SF is red.
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3.1.5.3.2 DHCP Mode configuration steps

In DHCP mode, the PRM Gateway device name needs to be configured. The device name is made of a
fixed part (“TCSEGPA23F14F)" as well as a 3 digits numerical extension, whose value is between 0 and
159. This numerical extension corresponds to the code set on the PRM Gateway rotary switches.

In the following DHCP configuration example, the configured device name is “TCSEGPA23F14F001".

e DTM configuration

o Inthe DTM Browser view, double-click on the DTM “BMEP58_ECPU".
DTM Browser

' {30 Host PC

(=8 17 < 10.126. 105.30 > BMEP58_ECFU
.2, Remote Bus
-3, Distributed Bus
i L\; « Modbus: 10. 126, 105.33 > PRM_Gateway

o Inthe device list, select the PRM Gateway.

%= BMEP5E_ECPU
li' Communication

BME P58 2040

- Channel Properties

C o TCPAP

E| Services

: Address Server

,__—_| EtherMet/IP Local Slaves
B Local Slave 1l

f Items

E| Local Slave 2

i Items

E| Local Slave 3
. Items

- Device List

E| [001] BMECRA_D01 <EIP: 10.126.105.32>

o Exclusive Owner

- [036] PRM_Gateway <MDB: 10126105.33=
Logging

o Select the Tag “Address Setting”.
The DHCP mode is in status “Disabled"”.
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Address Setting | Request Setting

IP Configuration

People for Process Automation

IP Address: 10 . 125 . 105 . 33

Subnet Mask: 255 . 255 .252 . O

Gateway: 10 . 1xs . 105 . 30

Address Server

DHCP for this device: Disabled -
Identified by: Device Name
Identifier: TCSEGPAZIF 147000

o Select the option “Enable” and change the identifier from TCSEGPA23F14F000 to
TCSEGPA23F14F001.

Address Server

DHCP for this device: f [Enabled -
Identified by: Device Name
Identifier: TCSEGPAZ23F14F001

o Save the new settings by clicking on the button “Apply”.

Lo O em ]

o Double-click on the PRM Gateway DTM.
DTM Browser

{33 HostPC
E---[_E < 10.126.105.30 > BMEPS8_ECPU

% Remote Bus

%4, Distributed Bus
e L,\; < Modbus: 10. 126, 105. 33 > PRM_Gateway

o The device name is automatically updated to the new device name “TCSEGPA23F14F001".
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DHCPIFDR Server
Parameters of this section need to be filed if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.

Device Name

TCSEGPAZ23F14F 001 Extension[000..158](rotary switches value)

|:| Backup the PRM configuration in FDR server on download.

o Select the option “Backup the PRM configuration in FDR server on Download".

DHCR/FDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.
Device Name

TCSEGPAZAF14F o001 Extension[000..159](rotary switches value)

fﬂackup the PRM configuration in FOR server on download.

o Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

¢ PRM address configuration

Realize at first a Clear IP as explained in the previous chapter.

Shut down the PRM Gateway power supply.

Remove the PRM Gateway from its backplane.

Set the address 0 for the upper rotary switch and 1 for the lower rotary switch.

o O O O

Mount the PRM Gateway on its backplane.
Energize the PRM Gateway.
The PRM Gateway LED SF is red.
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Remarks:

The DHCP mode allows an address configuration between 0 and 159. That means device name from
TCSEGPA23F14F000 to TCSEGPA23F14F159. The two first digits correspond to the upper rotary switch
value multiplied by a factor 10 and the last digit corresponds to the lower rotary switch value.

e Rotary switches configuration example for device name TCSEGPA23F14F148:
"148"

«14" are the two first digits of 148

(14)10=(E) 16

.8" is the last digit of 148

(8)10=1(8) 16

=>» Schneider Electric recommends not using names between TCSEGPA23F14F060 and
TCSEGPA23F14F099.

3.1.5.3.3 Stored mode configuration steps

e DTM configuration
o Inthe DTM Browser view, double-click on the DTM BMEP58 ECPU.
DTM Browser

{3 Host PC
SR 1] < 10.125.105.30 > BMEP58_ECPU

w24, Remate Bus
=-%g, Distributed Bus
. L,it, < Modbus: 10, 126, 105,33 = PRM_Gateway

o Inthe device list, select the PRM Gateway.

BMEP58_ECPU
|i' Communication
BME P58 2040

=~ Channel Properties

i TCR/IP
B~ Services

L Address Server
EtherMet/IP Local Slaves
Local Slave1

Iterns
Local Slave 2
- Items
Local Slave 3
Tterns
=~  Device List
: [001] BMECRA_001 <EIP: 10.126.105.32>

- Exclusive Owner
[036] PRM_Gateway <MDB: 10.126.10533>

..... Logging
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o Select the Tag “Address Setting” and select the status “Disabled”.

- Address Setting | Request Setting

IP Configuration

IP Address: 0 . 125, 105 . 33
Subnet Mask: 55 . 255 .252 . 0
Gateway: 0 .12 . 105. 30

Address Server

DHCP for this device: f lDisabIed -
Identified by: Device Name
Identifier: TCSEGPAZ23F14F001

o Save the new settings by clicking on the button “Apply”.

oK || cancd [ Aeey

o Double-click on the PRM Gateway DTM.
DTM Browser

{30 Host PC

=48 < 10.125.105.30 »» BMEPSB_ECPU
Dﬂl; Remate Bus
-4, Distributed Bus

i L_@ < Modbus: 10,126, 105.33 > PRM_Gateway

o This disables automatically the DHCP mode.
DHCPRIFDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

D:reate an entry for this device name in the DHCP server.

Device Name

TCSEGPAZIF14F 01 Extension[000..155)(rotary switches value)

Backup the PRM configuration in FDR server on download.
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o Unselect the option “Backup the PRM configuration in FDR server on download”.

DHCRIFDR Server
Parameters of thiz section need to be filled if you want to use a DHCP/FDR server.

Create an entry for this device name in the DHCP server.
Device Name

TCSEGPAZAF14F o001 Extension[000..159](rotary switches value)

f |:| Backup the PRM configuration in FDR server on download.

o Save the new settings by clicking on the button “Apply".

oK || cancd [ Aeey

e PRM address configuration

Realize at first a Clear IP as explained in the previous chapter.
Shut down the PRM Gateway power supply.

Remove the PRM Gateway from its backplane.

Configure the Store Mode.

o O O O

Set the address 0 for the upper rotary switch and C for the lower rotary switch.

Mount the PRM Gateway on its backplane.
Energize the PRM Gateway.
The PRM Gateway LED SF is red.

For the next steps, the PRM Gateway IP address is configured with the DHCP mode, with the device name
“TCSEGPA23F14F001".
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3.1.6 Connection to PLC

The first download will have to be done with the USB interface because no IP addresses are set in the
PLC.

In this example, the PLC IP address is at first downloaded via USB. Then, it is the Ethernet connection
which is used to download the other parts of the project configuration.

3.1.6.1 Connection via USB interface

e (Connect the USB cable from the PLC USB port to the engineering station one.

¢ Inthe tool bar, click on the menu “PLC>Set Address".
File Edit View Services Tools Build Debug Window Help

g =E | Connect Ctrl+K
e | Set Address...
= M HE & 5
e Select the Address type “SYS” and the Media type “USB".

Set Address [ % [zl

v FLC Simulatar
Bandwidth...
Address Address
7] - 127.0.0.1 -
tedia tedia
[ Communication Parameters Communication Parameters ] [ Cancel l

[¥] Speed rate auto-adaptation at the end of download

Test if the connection is established by clicking on the button “Test Connection”.
o If successful, following message is displayed.
o Click on the button “OK".
UnityXL (=3

) Successfully connected to the currently selected target.
4

e (lick on the button “OK" to close the window “Set Address”.
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3.1.6.2 IP settings configuration download via USB
e Download the IP configuration in the PLC.
—>Refer to part 3.4.1 Project Compilation and part 3.4.2.1 Project Download in PLC to proceed.
3.1.6.3 Connection via Ethernet

¢ Inthe tool bar, click on the menu "PLC>Set Address".
File Edit View Services Tools Build Debug Window Help

=3 : Connect Ctrl+K
= R —
= -_-:-: Le" ) |

e Enter the PLCIP address as Address type and select the Media type “TCPIP".
In this example, the PLCIP address is 10.126.105.30.
.SetAddlss

(5| [nEsel]
v PLC Sirmlator
B andwidth...
Address Address
Test C li
10.126.105.30 - 127.0.0.1 -
Media Media
l Communication Parameters Communication Parameters l l Cancel ]
Speed rate auto-adaptation at the end of download Help

e Test if the connection is established by clicking on the button “Test Connection”.
o If successful, following message is displayed.

o Click on the button “"OK".
UnityXL (=22

:] Successfully connected to the currently selected target.

e (lick on the button “OK” to close the window “Set Address”.
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3.2 Field Network Configuration with GSD

3.2.1

PROFIBUS master settings configuration

e Double-click on the PRM Gateway DTM.

DTM Browser

{30 Host PC

=48 < 10.126.105.30 > BMEPS8_ECPU

: 3%1_?.; Remote Bus

=58 Distributed Bus
e

e Basic Settings configuration

B8 ] < Modbus: 10,126, 105.33 > PRM_Gateway

Version 1.00.00

o Configure the requested Baud rate, 500 kBaud in this example.
All standard Baud rates are available.
Configure the PROFIBUS master station address, @1 in this example.

Configure the HSA address, @126 in this example.

Bf PRM Master Cenfiguration
iﬁ General Settings
af Profibus Master Configuration
: f Basic Settings
; f Advanced Settings
e f 10 Scanning

e Advanced Settings.

o Profibus Basic Settings

Baud Rate:

TS: Profibus Station Address:

HSA: Highest Station Address:

o These timing parameters are automatically calculated.

@ Management -

TTR (Local): P
TTR (Total): # [ s
4 193

o Others Timings Management -

GAP: Gap Update Factor: m 2
TSL: Slot time: 7 |20
TRO'Y: Ready time: Bl |1
TQUE Quist Time: [0
© Calculated Timing -

Tid1: Time Idle 1: 3T
Tid2: Time Idle 2: S 10
© Profibus Cycle:

Profibus Cycle: j [ 3
Recommended Profibus Cycle: 3

thits

tbits

thits

thits

tbits

thits.

tbits

& Error Management -
Token Retry Limit:
Token Error Limit:
Message Retry Limit:

Response Error Limit:

MIN_TSDR: Smallest Station:

MAX_TSDR: Largest Station:

TSET: Setup Time:

o Devices Watchdog —

Default Devices Watchdog:

Minimum Devices Watchdog:

125
3
4
1
15
=ER toits
A F 10 s
m 1 thits
# [/ 15 ms
Faa ms
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o To edit them manually, select the check box and change the value.

& mr Management —

TTR (Local): 7 ses thits
TTR (Total): rd 1000 thits
= 2 ms.

o The standard parameter is written back when the check box is unselected.

O R Management —

TTR (Local): e thits
TTR (Total): rd [EF] 965 thits
= 1.93 ms

=>» Schneider Electric Recommended PROFIBUS cycle time = 1.5 x TTR

o 10 Scanning
Other timing parameters can be changed, as the PRM Watchdog time.

PLC Settings

5] Repetitive Rate £ Health Timeout -

Value: i [l ms Value: 1500 ms
Step: 5 ms
Recommended Value: f 5 ms

PRM Settings

o PRM Watchdog o Profibus Cycle:

Value: f |:| 300 ms Profibus Cycle: f 3 ms

e Save the new settings by clicking on the button “Apply”.

oK ] l Cancel ] l Apply
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3.2.2 GSD Library
3.2.2.1 GSD files import

e Inthe DTM browser, right-click on the PRM Gateway DTM and select the menu “Device

Menu->Additional functions>Add GSD Library".

{33 Host PC
=-§8 < 10.126.105.30 > BMEPS8_ECPU
5@ Remote Bus
EE‘E Distributed Bus

Delete Del
Field bus discovery

Sort by address

Connect

Disconnect

Load data from device
Store data to device

Copy
Paste

Online Parameter

Properties ALT+Enter

Print device ST

Configuration
Zoom out Ohserve

Expand all Diagnosis

Collapse all Additional functions Add GSD In Library

Remove GSD From Library
Set Physical Slave Address

Erase Configuration

1 : Modicon M580 remote drop R
MM o:eME xer 0400 Download Firmware
M ) ) : BMx cPs 2010

e (lick on the button “Next".

GSD

®
PIRIOJF]I
This Wizard allows you to add GSD files BiUJS

< Back MNext = Cancel Help
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Select the directory by using the button “Browse” and then click on the button “Next”.
65D Addition

PROF.‘
T6Ts

r~ Select the Location of the GSD File{s) :

© Add Flefs)
' Add all the GSD from the Directory

Directory or File Name :

I\megrat\on\GSD - Test execution SEOTNEH_PA_LE_Micropilot_(1559_0x01_0x01_PALIB

¥ Look in Subfolders

e GSD files usable are registered in the GSD Library. Select the location of the file(s) and
lick on Nexd: button to insert the GSD files in the base.

< Back Net > Cancel | Hep |

e The Micropilot GSD file is ready to be imported.
Click on the button “Next".

GSD Addition
®
PIRIO[F]!
#0006

Name | Status | File Name | Hardware Release | Softy

/ Micropilot S Mo emor. Ready to be added.  EH3x1553.GSD Al

sl

4| m |

List of the files ready to be added in the library. You can

i
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition WMiew Selected Fils I

Analyze Emors

= Back MNext > Cancel Help

e Theimportis completed.
Click on the button “Finish” to close the window.
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e Open the Hardware Catalog by clicking on the menu “Tools->Hardware Catalog”.
File Edit View Services ITuols Build PLC Debug Window

BeldsES E@ | v Project Browser Alt+1

45 [T = |Q_ o | Hardware Catalog Alt+2

DT - Types Library Browser Alt+3

| = pr—— Operator Screen Library Alt+4
ne 4

o (Click on the button “Update” to update the DTM catalog database.

T e

Device Type Wendar Version Date
E ALTIVART1 Revision ... Device Schneider Bectric 27
E ALTIVARY1 Revision ... Device Schneider Bectric 33
| BME AHI 0812 Gateway Schneider Electric 10450 | 20140523
BME AHO 0412 Gateway Schneider Electric 10450 | 20140523
i BMEMOCD301 Communication Schneider Hectric 15130 2014-11-18
E BMEMNOCO307 from ... Device Schneider Hectric 11
i BMEMOCD311 Communication Schneider Hectric 15130 2014-11-18
E BMEMNOCO317 from ... Device Schneider Hectric 11
E BMEF581020 from E... Device Schneider Hectric 13

——

[[4] r[»[\ Em0Bus A PLChus }, DTM catalog [

o Following Message Box is displayed.

Click on the button “Yes".
e — =

—
@ The DTM Catalog seems to be up of date\Would you like to update it?
A e

| Yes ] [ Nao

o Select the Tag “DTM catalog”.
The Micropilot GSD file is now in the database.

- All devices - Device Type Vendor ‘Version Date =
Device types oF  Liguisys M CL/CCM23 /DP /2.30 Device Endress+Hauser 1.5.152.344 20150318
& Vendors = BZF  Liquisys MCL/CCM2°3/PA/2.30 Device Endress+Hauser 1.5.152.344 20150318
- Advanced Micro Controls| ™| 777 Micropilot / FMR&c / PA / FW 1.00.22 / .. Device Endress-+Hauser 140126 20140516
~ AGM Electronics, Inc. 7 Micropilot / FMRSc / PA/ FW 1.01.22/ ... Device Endress+Hauser 15.0.168 2014-08-01 3
- Beckhoff Automation | Micropilot 5« from G5D) Endress+Hauser Profile 3.02
-~ Endress + Hauser ¥ Micropilot Il / FMR 23¢/ PA / V2.00 Device Endress-+Hauser 1.5.152.344 | 20150319
+ Endress+Hauser ¥ Micropilot M/ FMR 25¢ / PA / V04.00 Device Endress-+Hauser 15152344 | 20150319
+ HMS Industrial Networks Micropilot M / FMR 25 / PA / V5a Device Endress+Hauser 15152344 | 20150319
. ;- Rockwel Attomation Micropilot M / FMR Zoc / PA / V1.0 Device Endress+Hauser 15152344 | 20150319
4| 1 3 Micropilot M / FMR 2ec / PA /V2.00 Device Endress+Hauser 1.5.152.344 20150319 -
[ <[] E10Bus  PLChus }, DTM catalog

SD01463S/04/EN/01.15 37/96



Scl&nelder

Electric

Endress+Hauser £71]

People for Process Automation

Integration Tutorial SEO1

3.2.2.2 GSD revision installation

Version 1.00.00

e Two GSD files cannot have the same name. The name needs to be changed.
In this example, the target is to implement to GSD files which have the same name but other

Hardware Release and Software Release.

P S Ty — . —
® ®
PIRJOJF[ 1 PIRJO[F] !
BlUJS BJU[S
Name [ Status File Name Hardware Release | Software Release | Vendor Name Product Type
0 PROMAG 50 PA A GSD with a same version already exists. Ready EH3_1525GSD Al 3 Endress+Hauser PA
! PROMAG 50 PA Profile 3.0 Duplicated device name. EHIX1525G50 A3 Endress+Hauser

-/ PROMAG 50 PA Profile 3.0 No emor. Ready to be added.

4 1 | 3

List of the files ready to be added in the library. You can
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition.

View Selected File

Analyze Emors I
There is a duplicated device name in the list. The comesponding GSD will not be added.

< Back Next > Cancel | Hep |

EHXc1525GSD Endress + Hauser PA

4 [ 1 | +

List of the files ready to be added in the library. You can
change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition.

View Selected File |

Analyze Emors |

There is a duplicated device name in the list. The comesponding GSD will not be added.

< Back Nezt > Cancel Help

e The name of the marked one needs to be changed.

G5D Addition

PROF)‘
BJU[S

Name | Status
€ PROMAG 50 PA A GSD with a same version already exists. Ready to b

0 PROMAG 50 PA Profile 3.0 hw3 A GSD with a same version already exists. Ready to by

w/ PROMAG 50 PA Profile 3.0 No emor. Ready to be added.

4 m | b

List of the files ready to be added in the library. You can

change the device name by clicking on the list or pressing the
F2 key. Click on Next to complete the addition. Miew Selected File
Analyze Emors |
< Back Next > Cancel | Hep |

e The two GSD files are located in the Hardware Catalog with 2 different names.

Device Type Vendor Version Date
= PROMAG 50 PA from GSD) | Device | Endress+Hauser | Profile 3.0 | |
=| PROMAG 50 PA Profile 3.0 w3 from G5D) | Device | Endress+Hauser | Profile 3.0 | |
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3.2.2.3 GSD family slave structure

e A GSD family slave structure is available in the Hardware Catalog with different sections as Device
types, Vendors, Groups and Protocol.

o All GSD drivers are sorted in the section:

o Device types—>Devices.

o Vendors>Endress+Hauser (2 times).
o Protocols>Profibus DPV1.
o]

Groups—>DTM specific.
Hardware Catalog
- All devices - Device Type Vendar Version Date =
Device types £ Prosonic M Profile 3.0 from G5D) Device Endress+Hauser Profile 3.0
Vendors E] Prosonic M from GSD) Device Endress+Hauser Profile 3.0
& (:3“"-'95 El Cerabar M 5¢ from GSD) Device Endress+Hauser Profile 3.02
- DTM Specfic =| |£]  Dettabar S evolution V.01 from GSD) Device Endress +Hauser Profile 3.02
- Blectrochemical Analy... || |Z Detiapilot M 5x firom GSD) Device Endress+Hauser Profile 3.02
! - Flow E] Levefflex 5 from GSD) Device Endress+Hauser Profile 3.02
Level £ Deltabar M 5 from GSD) Device Endress+Hauser Profile 3.02
- Not speciied £ Frowid 200 PA from GSD) Device Endress+Hauser Profile 3.02
- Pressure El Promag 100 DF from GSD) Device Endress+Hauser Profile 3.02 .
« |E] Corabar 5 evolution V4.01 firom GSD) Device Endress=Hauser Profils 3.02 El
3 = Micropilot B¢ from GSD) Device Endress+Hauser Profile 3.02 &
4[4[ »]r [\ E10Bus } PLCbus } DTM catalog

e Another way to display the GSD files is to right-click on the Gateway DTM and to select the menu
“Device menu—>Additional functions=>Remove GSD From Library”.

DTM Browser
{53 HostPC
E‘"E\? < 10,126,105,30 > BMEP58_ECPU
-5@ Remote Bus
=5 Distributed Bus
< Modbus: 10, 126.105.33 > PRM_{
< PRM_( y:40 > Prosoni
< PRM_Gateway:41 > Liquiline, Add...
< PRM_Gateway: 14 > PROMA Delete Del
< PRM_Gateway: 16 > Prosonit .
< PRM_Gateway:21 > TEMP_1
< PRM_Gateway: 11 > Cerabar
< PRM_Gateway:20 > Deltaba
« PRM_Gateway: 18 > Deltapil Connect
< PRM_Gateway: 19 > Micropil
L, < PRM_Gateway:45 > Promag,
£| <PRM_Gateway:42 > PROMAI Load data from device

Sort by address

Disconnect

Store data to device

Online Parameter

Properties ALT+Enter
3

Print device
Zoom in
Zoom out
Expand all Additional functions Add G5O In Library
Collapse all Remaove GSD From Library
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e Installed GSD files can be sorted according to the File Name/Manufacturer/Category/Device
Name.
|" GSD Deletion from Device Library =
PIRJO]F] I s
Soit by [Marutachrer =]

=]
=) Endress + Hauser

B¢l P4

B¢ PA

Prasonic b Profils 3.0
Prasonic § FMUA0

Delete Selected Fie(s] | ViewSelected Fie | Close | Heln

3.2.3 Field Device Configuration with GSD
3.2.3.1 New field device

e Inthe DTM browser, right-click on the PRM Gateway DTM and select the menu “Add".
DTM Browser '

{53 HostPC

=48 < 10.126.105.30 » BMEPS8_ECPU

P»Q_E Remote Bus

%8 Distributed Bus

RN - Modbus: 10,126, 105.33 = PRM_Gatewsauw

-

e Select the GSD file “Micropilot 5x” and click on the button “Add DTM".

Add ==
Device Type Vendaor i Date -
EF Liquisys M /CUM 23 /P... Device Endress+Hauser 5.15... | 20150319
LZF Liquisys M CL / CCMZ*3 /. Device Endress+Hauser 5.15... | 20150318
LEF Liquisys M CL / CCMZ*3 /.. Device Endress+Hauser 5.15.. | 20150318
TEH pilat / FMR%Sx / PA /.. Device Endress+Hauser 4.0... | 20140516
LZF Micropilat / FMR%c / PA /. Device Endress+Hauser 5. 2014-0801
I Micropilot 5x from GSD) i Endress+Hauser |
ZF Micropilet Il / FMR 23x / ... Device Endress+Hauser 8.15.. | 2M503-19
LF Micropilot M / FMR 28x /... Device Endress+Hauser | 1.5.15... | 20150319 |E|
LZF Micropilat M/ FMR 25« / ... Device Endress+Hauser 515 | 20150319 —
ZF Micropilot M / FMR 2xx / ... Device Endress+Hauser 5.15... | 20150319
LF Micropilot M/ FMR 2ac /.. Device Endress+Hauser | 1.5.15... | 20150319
LZF Micropilot M/ FMR 200 / ... Device Endress+Hauser 5.15... | 20150319
ZF Micropilot M / FMR 2xx / ... Device Endress+Hauser 5.15... | 20150319
LF  Mulicap / FEC 14 /V1.0 Device Endress+Hauser 5.15.. | 20150319
LZF Mycom S /CLM153 cond ... Device Endress+Hauser 5.15... | 20150319
ZF Mycom S /CLM153ind / .. Device Endress+Hauser 5.15.. | 20150319
AEF Mycom S /CPM 153 / PA.. Device Endress+Hauser 515, | 2050319
LZF Mycom S/ CPM 153 / PA Device Endress+Hauser 20150315
F_Mvnm Cond C/Clx 431 Device Frdress+Hanser 5 1F M15N319 7
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e Confirm the choice by clicking on the button “Yes".
Modification Authorization [-22]

l; Do you confirm the modification 7

= [

e (lick on the button “OK".

i’lnperﬁs of device ? .

General | Device ir ion | DTMir ion I Pratocol ir ion

DTM name management

e [\licropilot B¢ from GSD)

Tag name :

Default /O vision management
Defautt input 140 vision
Variable name : Micropilot_Fec_from_GSD_IN

Default output /0 vision
Variable name : Micropilot_%c_from_GSD_OUT

[ ok ][ canced |[ Hep |

e The Micropilot is inserted in the DTM browser Project structure with the address 126.
DTM Browser

{3 Host PC

B- [E < 10.126.105.30 > BMEP5S_ECPU
----- 3@ Remote Bus
E 3@ D|5tr|buhed Bus
=2 Lw < Modbus: 10,126, 105.33 = PRM_Gateway
%, < PRM_Gateway: 126 > Micropilot_5x_from_GSD
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3.2.3.2 10 modules configuration

e Double-click on the generic DTM “Micropilot_5x_from_GSD".

e This opens the device DTM configuration window.

Micropilot ¢ from GSD) - Endress+Hauser
Profibus Remote Master - Generic Device DTM - Schneider Electric

-4 Device Information
43 GSD View
.7 Device Parameters
E}--ﬁf Modules Configuration
$> AL OUT {Analog Input)
$> AL OUT {Analog Input)
$9 AL OUT (Analog Input)
$> AL OUT (Analog Input)
%) AL OUT (Analog Input)
$> AL OUT (Analog Input)
$> DL OUT (Digital Input)
-9 DL OUT (Digital Input)
%) DL OUT (Digital Input)
%2 DL OUT (Digital Input)
$> AQ: 5P (Analog Output)
99 A0: SP (Analog Output)
-9 AD: SP (Analog Output)
-8 AD: SP (Analog Output)
-9 DO: SP (Digital Output)
%) DO: 5P (Digital Output)
-9 DO: SP (Digital Output)
99 DO: SP (Digital Output)

e Select the menu “Modules Configuration”.
o The default 10 module configuration is already done according to GSD file.

=-B Micropilot 5x
B Py D;i(ﬂ"fmmtim @ Madules Configuration
© G50 View Informatior
V| Device Parameters
- Input Size (0- 244y 38
[EE’.-d Modules Configuration| i
$> AL QUT (Analog Input) Output Size [0 - 244) 2
AL QUT (Analog Input)
g e (Ana‘oglnzuﬂ Tofel /0 Size[1- 488 G5
$9 AL OUT (Analog Input) Humber of Configured Modules (1- 181 18
£ AL OUT (Analog Input)
$9 AL OUT (Analog Input) Modules in GSD
£ DL OUT (Digital Input)
g; DE OUT (Digital Input) Mame Input Output  Canfiguration =
|
£ DL OUT (Digital Input) A1: BUT (analog Input) 5 0 D42 B4 DKOB 0005
$# DL OUT (Digital Input) Dl: DUT [Digital Input) 2 0x91
#0 AQ: SP (Analog Output) 40: 5P (Analog Output] 0 5 032,034, 0408, 0405
#2 AO: SP (Analog Output] 40: 5P.AB.POS 7 5 0606, 0¢04, (486 008040 _
$2 AO: SP (Analog Output) R = - TS
@ A: SP (Analog Dutput)
% DO: SP (Digital Dutput)
ﬁ’ DO: SP (Digital Qutput) Configured Modules
$ DO: 5P (Digital Output)
H Input  Output  Configurat &
#2 DO: 5P (Digital Output) ame S S T
Al: OUT (Analog Input) g 0420484 0x08,0605 Add
A1: AUT (analog Input) 5 0 042, 034,0408, 0405
Al: OUT (Analog Input) 5 0 0142, 00840208005 Remove
A1: AUT (analog Input) 5 0 0nd2, 0340408005 _
P - - nnnnen oo o Hove Up
O T | ¢
Move Down

o Corresponding slot definition in GSD file:
For each slot, there is at first the default module and then the allowed one.
For example, for Slot(1):
= Default module is Module 1.
» Allowed modules are Module 1 and Module 17.
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Rkttt Additional keywords for module assignment — dddedodddedodddor
slotDefinition
slot(1) = "AI 1 (Analog Input)" 1,17
slot(2) = "AT 2 (Analog Input)" 1,17
slot(3) = "AI 3 (Aanalog Input)" 1,17
slot(4) = "AIL 4 (Aanalog Input)"” 1,17
Slot(5) = "AI 5 (Analog Input)"” 1,17
Slot(6) = "AI 6 (Analog Input)" 1,17
slot(7) = "DI 1 (Digital Input)" 2| 2,17
slot(8) = "DI 2 (Digital Input)" 22,17
slot(9) = "DI 3 (Digital Input)" 2)2,17
slot(10) = "DI 4 (Digital Input)" 22,17
slot(11) = "A0 1 (Analog Output)"” 3| 3,4,5,6,7,8,9,17
Slot(12) = "A0 2 (Analog Output)"” 3] 3,4,5,6,7,8,9,17
Slot(13) = "A0 3 (Analog Output)"” 3] 3,4,5,6,7,8,9,17
Slot(14) = "A0 4 (Analog Output)" 313,4,5,6,7,8,9,17
slot(15) = "p0 1 (Digital Output)" |10{10,11,12,13,14,15,16,17
slot(16) = "DO 2 (Digital OQutput)" |10f10,11,12,13,14,15,16,17
slot(17) = "DO0 3 (Digital Output)" |10/10,11,12,13,14.15,16,17
slot(18) = "Do 4 (Digital output)" |10/10,11,12,13,14.15,16,17
EndslotDefinition

Default modules

o Corresponding modules definition in GSD file
Module = "AI: OUT (Analog Input)" 0x42,0x84,0x08,0x05

EndModule

Module = "DI: OUT (Digital Input)" 0x91

EndModule

Module = "A0: SP (Analog Output)" 0x82,0x84,0x08,0x05

éndMuduWe

Module = "AO: SP,RB,POS" 0xC6,0x84,0x86,0x08,0x05,0x08,0x05,0x05,0x05
EndModule

Module = "AO: SP,CB" 0xC3,0x84,0x82,0x08,0x05,0x0A

EndModule

Module = "AO: SP,RB,POS,CB" 0xC7,0x84,60x89,0x08,0x05,0x08,0x05,0x05,0x05,0x0A
EndModule

Module = "AO: RC_IN,RC_OUT" O0xC4,0x84,0x84,0x08,0x05,0x08,0x05
EndMuduWe

Module = "AO: RC_IN,RC_OUT,CB" OxC5,0x84,0x87,0x08,0x05,0x08,0x05,0x0A
EndModule

Module = "AO: SP,RB,RC_IN,RC_OUT,POS,CB" OxCB,0x89,0x8E,0x08,0x05,0x08,0x05,0x08,0x05,0x08,0x05,0x05,0x05,0x0A
EndModule

Module = "DO: SP (Digital Output)" OxAl

EndModule

Module = "DO: SP,RB" OxC1,0x81,0x81,0x83

%ﬁdMudu1e

Module = "DO: SP,CB" OxC1,0x81,0x82,0x92

éﬁdModu1e

Module = "DO: SP,RB,CB" 0x(C1,0x81,0x84,0x93

%ﬁdMndu1e

Module = "DO: RC_IN,RC_OUT" 0xC1l,0x81,0x81,0x8C

EndModule

Module = "DO: RC_IN,RC_OUT,CB" OxC1l,0x81,0x84,0x9C

%adMudu1e

Module — "DO: SP,RB,RC_IN,RC_OUT,CB" OxCL,0x83,0x86,0x0F
16
EndModule

Module = "Free Place" 0x00
17

EndModule
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e This default 10 module configuration can be changed.
In the following example, the module 1 “Al" of Slot 1 is replaced by the module 17 “Free place”,

according to the GSD 10 module definition.

o Select the module “Al” and click on the button “Remove”.

=% E Micropilot 5x
-4 Device Information
€ GSD View
-7 Device Parameters
E--ﬁ' Medules Configuration

-8 AL OUT (Analog Input)
.. AL OUT (Analog Input)

99 AL OUT (Analog Input)
-8 AL OUT (Analog Input)
-9 AL OUT (Analog Input)
8@ AL OUT (Analog Input)
.. DI: OUT (Digital Input)

99 DI OUT (Digital Input)
.- DI OUT (Digital Input)
.- DI OUT (Digital Input)
-8 AO: SP (Analog Output)
.9 AO: SP (Analog Output)

92 AD: SP (Analog Dutput)
-8 AO: SP (Analog Output)

9 DO: 5P (Digital Output)
-8 DO: 5P (Digital Output]
-9 DO: SP (Digital Output)

9@ DO: SP (Digital Output)

o The module “Al” of slot 1 is deleted.

B--’/ Micropilot 5x

€9 Device Information

€ GSD View

7| Device Parameters

E|/ Modules Configuration
92 AL OUT (Analog Input)

-9 AL OUT (Analog Input)
42 AL OUT (Analog Input]

-9 AL OUT (Analog Input)
2 AL OUT (Analog Input)

.. DI: OUT (Digital Input)

-4 DI OUT (Digital Input)

.. DI: OUT (Digital Input)

-8 DI: OUT (Digital Input)

-9 AO: SP (Analog Output)

-89 AO: SP (Analog Output)
¥ AO: SP (Analog Output)

-8 AO: SP (Analog Output)
% DO: SP (Digital Qutput)

-9 DO: SP (Digital Output)
%2 DO: 5P (Digital Output)

-9 DO: SP (Digital Output)

€ Modules Configuration

Version 1.00.00

Informaticrn
Input Sige (0- 244 38
Dutput Size (0- 244 29
Total 1/0 Size (1 - 4381 B8
Mumber of Configured Madules [1 - 18]: 18
todules in GSD
Mame Input Output  Configuration =
Al QUT [Analog Input) 5 1} 0=42,0:84,0208,0<05 (o
DI OUT [Digital Input] 2 0 0=91
AQ: 5P [Analog Output] 1] 5 0x82 0484.0:08, 0405
AD: SPRBPOS 7 5 06, 0u84, 086,008, 0xl _

Sy

| »

Configured Modules

Output

Configuration

€ Modules Configuration

Al: OUT [Analog Input) 5 0 0x42.084.0:08,0:05
Al DUT [Analog Input) 5 0 042 0484008, 0x05
Al: OUT [Analog Input 5 0 0x42 [x84.0:08,0x05 =
;.l-n..na FE— r__r[_ - - .qnn.nmnnenr ;
Information
Input Size (0- 244 33
Dutput Size (0- 244 28
Total|/0 Size (1 -8 &
MNumber of Configured Modules (1 - 18): 17
Modules in GSD
Marme Input Output  Configuration =
A1 DUT [Analag Input] 5 o 0x42,0x84,0:08, 0205 4
DI OUT [Digital Input] 2 o 0x91
A SP [Analog Output] 1] 5 0182 04840108, 0x05
Al: SPRBPOS 7 ] 006 O34, 086, 0208,0:C _
(,-‘. rmen - - m—anmﬂmnimn’,
f Caonfigured Modules
Mame Input Output  Configuration =
Al: OUT [Analog Input]) g a 0x42,0:84,0:08,0:05 (I
A1 OUT [Analag Input] 5 o Dxd2,0x84 008, 0205
Al OUT [Bnalog Input] a o Dx42,0x84,0:08,0:05
Al: OUT [Analog Input 5 1] 0142 04840108, 0x05 =
‘..‘Vm.,“ T o= - A neennn e

]

Add
Femove
Maove Up

Move Diovn
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o Select the module “Free place” and click on the button “Add".

E|/ Micropilat 5x
€9 Device Information
& GSD View

& Modules Configuration

Infarmation
7| Device Parameters n
= / Modules Cenfiguration (gD |I= 20
-89 AL OUT (Analog Input) Output Size (0- 244 29
-8 AL OUT (Analog Input) &
Total 1/0 Size (1 - 488}
¥ AL OUT (Analog Input) otal 11D Size 1 - 458}
@ AL OUT (Analog Input) Number of Configured Modules [1 - 18] 17
-9 AL OUT (Analog Input)
-4 DI OUT (Digital Input) Modules in GSD
%9 DI OUT (Digital Input)
-9 DI OUT (Digital Input) Hame Input Output  Configuration e
-2 DI OUT (Digital Input) DO: RC_IN,RC_OUT 2 2 04C1.0481.0481,048C
92 AD: SP (Analog Output) DO: RC_INRC_OUT.CE 5 2 0wC1,0481,0x84,069C

-89 AQ: SP (Analog Output) DO: SP.RE.RC_IN.RC_OUT CB 7 4 0401 .0483.0486.0:9F  —
-8 AD: SP (Analog Output)

%’ AQ: 5P (Analog Output) 4] m ] »
-89 DO: SP (Digital Output)
.9 DO: SP (Digital Output)
-8 DO: SP (Digital Output) 7 Configured Modules

%9 DO: SP (Digital Output)

Mame Input Output  Configuration =
Al: OUT [Analog Input) 5 1] (1442 (1134, 008 005 [ -
A1 OUT [Analog Input) 5 o Owd2,0x84,0:08, 005
Al OUT [Analog Input] 5 0 (d2, 01840408, 0005 Remove
Al: OUT [Analog Input 5 1] (Oxd2.0x84. 0408 005 =
M - - fannnin ann o Mave Up
4 . ] ¢

Move Down

o The module “Free place” is added in the configuration but still not on the right slot.

B-f Micropilot 5x

€ Device Information
€ GSD View

7| Device Parameters
B,/ Modules Configuration

& Modules Configuration

Infarmation

Input Size (0244

4 AL OUT (Analog Input) Output Size (0- 244 28
-2 AL OUT (Analog Input)
g AL OUT (Analog Input) R ol
3, AL OUT (Analog Input) Mumber of Configured Modules [1 - 18} 18
#9 AL OUT (Analog Input)
-89 DL OUT (Digital Input) Modules in GSD
-2 DI OUT (Digital Input)
$> DL QUT (Digital Input) Mame Input Output  Configuration =
$> DI QUT (Digital Input) DO: RC_INRC_OUT 2 2 OxC1.0x81 0x81,0x8C
%) AQ: 5P (Analog Cutput) D0: RC_INRC_OUT.CE 5} 2 0%C1.0x81.0x84.059C
% AD: SP (Analog Output) DO: SP.RB.AC_INRC_OUT OB 7 4 DCT (03 B8 S —
§> AO: SP (Analog Output) Free Place 1] 1] 0x00 =
? AQ: SP (Analog Output) 4 [T} |
$2 DO: 5P (Digital Output)
.29 DO: SP (Digital Output)
.4 DO: SP (Digital Output) 7 Canfigured Modules
SRu{Bigrtal Output) MHame Input Output  Configuration g
DO: 5P [Digital Output] o 2 ] A
D0O: 5P (Digital Output] 1] 2 0=l
D0: 5P [Digital Dutput) 0 2 (il

Move Down
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e Select the module “Free place” and click on the button “Move Up” to move the module to the

correct slot.
f Configured Maodules

Mame Input Output  Configuration =

D0: 5P (Digial Output] 1] 2 0=t aeld
D0: 5P (Digial Output] 1] 2 Oma1

D0: SF [Digital Dutput) 0 2 0241 Remaove

1

e Flace

towve Lip

Move Down

e The module “Free place” is now on the right slot.
[=-# Micropilot 5x

o Device Information

4% GSD View

] Device Parameters

) Modules Configuration

Infarmation
Irput Gize (0 - 2443, 33

(95 Free Place|
. AL OUT (Analog Input]
s EA::\:E I:xt; Total 140 Size (1 - 408 B

$> AL OUT (Analog Input) Mumber of Configured Modules (1 - 18] 18
$> AL OUT (Analeg Input)
8) AL OUT {Analeg Input)
.9 DI OUT (Digital Input)

Output Size [0 - 244 23

Modules in GSD

.82 DI OUT (Digital Input) Name Input  Output  Configuration =
$> DL OUT (Digital Input) D0: RC_IM RC_DUT 2 2 0nC1, 04810181, 0080
.42 DE OUT (Digital Input) D0: RC_IM.RC_OUT.CE 5 2 010281084, 025C
$> AQ: SP (Analog Output) D0: 5PRE.RC_IN.RC_OUT.CE 7 4 01,083,086, 0:9F m
.92 AQ: SP (Analog Output) Free Place 0 0 000 t
-89 A0: SP (Analog Output) < [0 T
#2 AD: 5P (Analog Output)
.89 DO: 5P (Digital Output)
? DO: 5P (Digital Output) f Configured Modules
& Pk oh (D!g!ta\ Sutput) MName Input Output  Configuration =
.89 DO: 5P (Digital Output) B
Free Place a a (0=00 o add
Al OUT [Analog Input] ] 1] (42 0x84,0-08 0205
Al OUT [&nalog Input) 5 1} (wd 2,084,008, 0205 Remave
Al: OUT [Analog Input] 5 a (42,0:84.0408,0:05 =
EORE T A = = Ere e L B3 Move Up
4 m |
Morve Dawn

e Save the configuration by clicking on the button “Apply”.

B == I [

=>» For the next steps, the 10 module configuration is the set to the default one.
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3.2.3.3 Field Device settings

e Double-click on the PRM_Gateway DTM.
DTM Browser

{30 Host PC

=88 < 10.125.105.30 > BMEPS8_ECPU
3%1_?.; Remote Bus
%@ Distributed Bus

=BV < Modbus: 10. 126, 105.33 > PRM_Gateway
< PRM_Gateway: 126 > Micropilot_5x_from_GSD

e The menu “Profibus Devices” is now available in the PRM Master Configuration view.

Profibus Remote Master Corfiguration Tool

[ PRM Gateway
2

& General Settings
@ Profibus Master Configuration
_.&F Basic Settings
o Advanced Settings
& [0 Scanning
=7 Profibus Devices

=B 126 Micropilot_5x from_GSD
.= DPVI Settings
= Profibus Settings
=@ 1o
! %’ Input Yariables
$> Output Variables

¢ PROFIBUS address
Select the menu "Profibus Devices”.

= PRM Master Configuration
& General Settings
¥ Profibus Master Configuration
& Basic Settings -
& s Sgettings Address Device Name
! & 10 Scanning 126 Micropilot_S=_from_... Endress+Hauser
-

5B 126 Micropilot_5x_from_GSD
= DPV1 Settings
& Profibus Settings
& Vo
$> Input Variables
! %’ Output Variables

o Aszsign Station Addresses to Devices

Vendor Type Version

Micropilot 5x ...  Profile 3.02

Address (0-128): 0 Assign Address Directly Applied to the selected device.

Give the new PROFIBUS address and click on the button “Assign Address”.

o]

In this example, the new PROFIBUS address is 19.

Address (0-128): [ Assign Address l Directty Applied to the selected device.
o New PROFIBUS slave address is updated.
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= PRM Master Configuration
& General Settings
---\@ Profibus Master Configuration

& Basic Settings ) .
& Ad d Setti Address  Device Name Vendor Type “ersion
Ivancel ngs

& 10 Scanning 19 | Micropiot_Sx_from GSD Micropilot 5x ... | Profile 3.02

E| Eﬂ Profibus Devices
19 Micropilot_5x_from_GSD
= DPV1 Settings

& Profibus Settings

o Aszsign Station Addresses to Devices

$> Input Variables
2 $> OQutput Variables

e DPV1 Settings
Select the menu “DPV1 Settings” and update the parameters if needed.

= PRM Master Configuration
= General Settings
- @ Profibus Master Configuration

€ DPV1 Settings

- Basic Settings DPV1 Enable: Enable Manufacturer Alarm:
& Advanced Settings
; & 10 Scanning WD Base 1ms: Enable Status Alarm:
£-# Profibus Devices
5B 19 Micropilot_5x_from_GSD Fail Safe: B Enable Update Alarm:
DPV1 Setti
- Enable Pull Plug Alarm: Check Cfg Mode: [}

& Profibus Settings
: o)
8’ I t Variabl Enable Process Alarm: ?.I:J[r;.aequence il 1Al of each type
nput Variables —ourt:

$> COutput Variables
Enable Diagnostic Alarm:

¢ PROFIBUS Settings
o The parameters “Profibus Settings” are configured automatically according to the GSD file.

& Device

ldent Number 0x 1559

O Profibus Settings

Byte Ordering: Big Endian -

MIN_TSDR: " thits
Watchdog: [F s00 ms
Minimum Slave Interval: [} x100 ps

&) Giobal Control

Sync Mode: D
Freeze Mode: |:|
i 2 3 4
Profibus Group: <
5 L] T 8

€3 Advanced Settings

Abort if Mo Answer (NA_To_Abort) |:|
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¢ 10 modules data structure configuration
The following part explains how to configure the device data structure, which is used in the logic.
This data structure is linked to the 10 module configuration done in the generic DTM.

o 10 Structure Names.
The 10 Structure Name is used to access to the data in the logic.

= PRM Master Configuration

.= General Settings ®
1@ Profibus Master Configuration

: = Basic Settings

& Advanced Settings 10 Structure Name: Micropilot_Sx_from_GSD

- 10 Scanning

-7 Profibus Devices

5@ 19 Micropilat_Sx_from_GSD
= DPVL Settings Default Structure Names

- Profibus Settings
= ﬁf’m Variables Management

g) Input Variables

%} Output Variables Import Mode: Reimport Variables Names

10 Structures Names

= The IO Structure Name can be edited. By clicking on the button “Default Structure
Names”, the default 10 Structure Name is written.

» The option “Import Mode" allows the user to change the variable type of the
allocated 10 modules. This option is default configured with “Automatic”. The
Automatic mode configures all variables with the type Byte Array.

o 10 modules configured in Automatic mode.
All'10 modules are configured automatically according to the defined |0 module
configuration in the device DTM.

* Input variables

B PRM Master Configuration ®
& General Settings

Input Variables

£ Profibus Master Cenfiguration =
" Basic Settings Type Offset  Size MName Comment E
| Advanced Settings Eisyear lo 15l Ao ralog oot vt L
.o 10 Scanning [lsytearr 5 5 Al_OUT_Analog_Input_IN_2 |
440 Profibus Devices [lsytear 10 5 AI_OUT_Anialog_Input_IN_3 i |
g [@leytear 15 5 AI_OUT_Analog_Input_IN_4
=8 19 Micropilot_5x from GSD [Eoytear 20 5 AI_OUT_Analog_Input_IN_5
% DPVL Settings [@eytear 25 5 AIOUT_Analog_Input_IN_6 s
- Profibus Settings = = :
@ 1o L
92 Input Variables Varisble Description
$2 Output Variables o ALOUT_Analog_Input_IN_1 Type: BYTE ARRAY
Offset: © Mumber: g Add Remove
Comment:

Bits Generation
Generate Bits
First Bit Offset:

Number Of its To Generate: 1
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= Qutput variables

= PRM Master Configuration

# G 1 Setti )  Output Variables
; eneral Settings

Profibus Master Configuration ot o —
& Basic Settings
» s _-_
. .= 10 Scanning Eoytear 5 AQ_SP_Analog_Output_OLT_12
£ A Profibus Devices Eleytzar 10 5 AO_SP_analog_Output_OLT_13
B 19 Micropilot_5x_from_GSD @Bleytear 15 5 AO_SP_analog_Output_OLT_14 L4
b ’ @eytear 20 2 DO_SP_Digital_Output_OUT_15
— D S BEloyear 22 2 DO_SP_Digital_Output_OUT_15 o
& Profibus Settings L = I .
ogf Vo
L% Input Variables Variable Description
-4 Output Variables e AO_SP_Analog_Output_OUT_11 Type: BYTE ARRAY
Offset: & Number: 3 Add Remove

Comment:

Bits Generation

Generate Bits
First Bit Offset: €
Number OF Bits To Generate: 1

o 10 modules configured in Manual mode.
The following example explains how to configure an analog input value variable structure
and its status.

= Select the “Manual” mode in the 10 Structure Names part.

Variables Management

Import Mode: Manual = l Reimport Variables Names l

* Following Message Box is displayed. Click on the button OK.
Manual Reimportation

I./'_“\-.I Device's variables could be now manually modified, but potential IO
"' modifications done in the device DTM won't be taken anymore into

~ account automatically. This action is not cancelable.

* Inthe Input variables view, the button “Remove” is now enabled.
Select the requested variable and click on the button “Remove”.

& Input variables

Type Offset  Size Name Comment
E--_
@leytear s 5 AI_OUT_Analog_Input_IN_2
-EybeArr 10 5 AI_OUT_Analog_Input_IN_3 R |
-Eybearr 15 5 AI_OUT_Analog_Input_IN_4
.EytEArr 20 5 AI_OUT_Analog_Input_IN_5
.EytEArr 25 5 AI_OUT_Analog_Input_IN_6 -
4| I | 2
Wariable Description
Mame: AI_OUT_Analog_Input_IN_1 Type: BYTE ARRAY
Offset: 2 Number: £ Add

Comment:
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= Thevariable “Al_OUT_Analog_Input_IN_1"is deleted and replaced by a free
module, whose size is 5 bytes.

€9 Input Variables

/ Type Offset  Size Mame Comment
__
-Eybeﬁw 5 AI_OUT_Analog_Input_IN_2
.EytEArr 10 5 AI_OUT_Analog_Input_IN_3 | 8
[leytear 15 5 AI_OUT_Analog_Input_TN_4
EyheArr 20 5 AI_OUT_Analog_Input_IN_5
EytEArr 25 5 AI_OUT_Analog_Input_IN_& -
f_\ I | 3

Wariable Description

Name: 7 FREE_O Type: BYTE ARRAY =
Offset: 0 Mumber: B Remove

Comment:

= Enter a new variable name and select the correct type. In this example, the new
name is “value_analoglnput_1" and its type is REAL.
Click on the button “Add” to validate.

€ Inputvariables

Fd

Offset  Size Name Comment =
0 5 FREE_O
5 5 AI_OUT_Analog_Input_IN_2 3
10 5 AI_OUT_Analog_Input_IN_3 L4
15 5 AI_OUT_Analog_Input_IN_4
20 5 AI_OUT_Analog_Input_IN_5
.BytEArr 25 5 AI_OUT_Analog_Input_IN_& -
« | il ] [
Variable Description /
Name: f Ivaluejnalnglnput,l I Type:
ot 0 e

Comment:

» The new REAL variable “value_analoglnput_1" is added.
The REAL value is made of 4 bytes. That means 1 byte is still free. This will be used
for the status.

9 Input Variables

/ Type Offest  Size Mame Comment
E-- value_analoginput 1 _
.FrEE 4 FREE_0
[@laytear 5 5 AI_OUT_Analog_Input_IN_2 4
BEleytear 10 5 AI_OUT_Anzlog_Input_IN_3
[Bloytear 15 5 AI_OUT_Analog_Input_IN_4
ByheArr 20 3 AI_OUT_Analog_Input_IM_5 -
4| 1] | 3

Variable Description ’/
Mame: value_analogInput_1 Type: REAL
ot 7 0 e 7 [2

Comment:
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= Select the module “FREE_0".
Enter a new variable name and select the correct type. In this example, the new
name is “status_analoglnput_1" and its type is BYTE.
Click on the button “Add” to validate.

€  Input Variables

/ Type Offset  Size MName Comment i
EBRreal 1] 4 value_analoglnput_1 5
L Fee Ja 1 Jmeeo | b
[@eytear s 5 AI_OUT_Analog_Input_IN_2 =
ByheArr 10 5 Al_OUT_Analog_Input_IN_3
[@leytear 15 5 AI_OUT_Analog_Input_IN_4
BytEArr 0 5 AI_OUT_Analog_Input_IN_5 -
:n| [T | F

Variable Description

Name: &7 status_analoginput_1 Type: f

Comment:

= The analog value with its status is configured.

€ Input Variables

'/ Type Offset  Size Mame Comment Bar
EFlReal 1] 4 value_analoglnput_1 | 3
Bleyte 4 1 status_analoginput 1 3
[Bleytearr 5 5 AI_OUT_Analog_Input_IN_2 L4
@Eleytear 10 5 AI_OUT_Analog_Input_IN_3

ByteArr 15 5 AI_OUT_Analog_Input_IN_4
Bleyear 20 5 AI_OUT_Analog_Input_IN_S =
4 [} | 2
Variable Description /
Name: wvalue_analoginput_1 Type: REAL
T o |2

Comment:

o Reimport Variables names
» The default variable configuration can be imported by clicking on the button
“Reimport Variables Names".

“ariables Management

Import Mode: Manual = I| Reimport Variables Mames

= (lick on the button “Yes" to validate.
Reimport Variables Names _. B

I.-"'_"‘-1 The variables names reimportation will erase already existing inputs and
W' outputs variables with automatically generated variables that come
from DTM. This action is not cancelable. Do you want to continue 7

e [
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» Inputvariables have again their default type.

| »

Offset  Size Name Comment
AI_OUT_Analog_Input_IN_1
AI_OUT_Analog_Input_IN_2
AI_OUT_Analog_Input_IN_3 | &
AI_OUT_Analog_Input_IN_4

AI_OUT_Analeg_Input_IN_5

AI_OUT_Analeg_Input_IN_& o

m | +

m

=
[ B, T BT T |

o The same principle is used to configure the Output variables.

Ejﬁﬁ PRM Master Configuration &  Outout Variables
L= General Settings
. Profibus Master Configuration
& Basic Settings Type Offset  Size Mame Comment
& Advanced Settings EYtEArr o 5 AO_SP_Analog_Output_OUT_3
Lo IO Scanning EVheArr 5 2 DO_SP_Digital_Output_OUT_11
£-# Profibus Devices Evheﬁ\rr *: 2 DO_5P_Digital_Output_OUT_12
Y, B 45 Promag_400_DP_from_GSD
..o DPV1 Settings
C;; :rgﬂbus Settings o = | 5
=
%’ Input Variables Variable Description
o8 4 Output Variables| Name: AQ_SP_Analog_Output_OUT_8 Type: BYTE ARRAY
Offset: o Number: E Add
Comment:

e Save the changes by clicking on the button “Apply”.
o [ o [ e ]

e For the next steps, analog inputs and analog outputs have been configured according the
Endress+Hauser format, ie 4 bytes and 1 byte Status (as described in the previous example).

3.2.4 PROFIBUS Timing parameters verification
3.2.4.1 Parameter MAX_TSDR

e Select the menu “Advanced Settings”
Check the parameter “MAX_TSDR : Largest Station” according the configured Baudrate. This

parameter can be found in the GSD file.
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=& PRM Master Configuration
General Settings
Profibus Master Configuration
& Basic Settings
Y anced Setings]
& 10 Scanning
-7l Profibus Devices
=-@ 19 Micropilot_Sx_from_GSD
.5 DPVI Settings
& Profibus Settings
& 1o
----- $> Input Variables
i $> Qutput Variables

Remark:

® Management
TTR (Local):

TTR (Total):

@ others Timings Management

GAP: Gap Update Factor:

T5L: Slot time:
TRDY: Ready time:

TQUI: Quiet Time:

o Calculated Timing
Tid1: Time idle 1:

Tid2: Time Idle 2:

o Profibus Cycle:

Profibus Cycle:

Recommended Profibus Cycle:

2713

E] 2713

= 5.426

37

100

thits.

thits

thits.

thits

thits

thits

thits

& Error Management
Token Retry Limit:
Token Error Limit:
Meszage Retry Limit:

Response Error Limit:

MIN_TSDR: Smallest Station:

Version 1.00.00

=K thits

MAX_TSDR: Largest Station:

E 100 thits

TSET: Setup Time:

o Devices Watchdog —

Default Devices Watchdog:

Minimum Devices Watchdog:

|1 thits

When several field devices are configured in a network, the MAX_TSDR parameter corresponds to the

highest value of these field devices.

3.2.4.2 Parameter Default Devices Watchdog

By use of Profibus PA field devices, Schneider Electric recommends to adapt the calculated parameter

“Default Devices Watchdog".

Steps to follow :

¢ Inthe “Basic Settings” configuration, the Baudrate has been set to 500 kBaud.
This configures automatically the parameter “Default Devices Watchdog” to 45ms.
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@&#@ PRM Master Configuration

.= General Settings

Profibus Master Configuration
& Basic Settings

>

& 10 Scanning

=7 Profibus Devices

19 Micropilot_5x_from_GSD
= DPVL Settings

& Profibus Settings

& 1o

$> Input Variables
$> Output Variables

Version 1.00.00

O mru t © Errorn
TTR (Local): 73 thits Token Retry Limit: 3
TTR (Total): [ 2713 thits Token Error Limit: 4
= 5.426 ms Message Retry Limit: 1
Responze Error Limit: 15

U Others Timings M

GAP: Gap Update Factor: |2 MIN_TSDR: Smallest Station: [ thits
TSL: Siot time: [ 200 thits MAX_TSDR: Largest Station: O 100 thits
TRDY: Ready time: | 1 thits TSET: Setup Time: [ thits
TQUI Quiet Time: E o thits.

o Calculated Timing o Devices Watchdog

Tid1: Time Idle 1: 7 thits Default Devices Watchdog: [ 45 ms
Tid2: Time Idle 2: 100 thitz. Minimum Devices Watchdog: 1 e

o Profibus Cycle:

Profibus Cycle: E 9 ms

Recommended Profibus Cycle: E ms

e Schneider Electric recommends setting this parameter to the calculated value of 45.45kBaud.
In the menu “Basic Settings”, select the Baudrate 45.45kBaud.

Ef PRM Master Configuration
& General Settings

i #” Basic Settings

f Advanced Settings
; f [Q Scanning

E f Profibus Devices

B f 19 Micropilot_5x_from_G5D

& DPVI Settings

f Profibus Settings
o 1o

%’ Input Variables
%’ Output Variables

E| f Profibus Master Configuration

o Profibus Basic Settings

Baud Rate: f 45.45 * | kbitsis

TS: Profibus Station Address: 1

HSA: Highest Station Address: 126
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e Select the menu “Advanced Settings”.
Crosscheck the calculated Baudrate.

Q..f PRM Master Configuration
...& General Settings
f Profibus Master Configuration
f Basic Settings
f Advanced Settings
f 10 Scanning
f Profibus Devices
54 19 Micropilot_Sx_from_GSD
L= DPVI Settings
Profibus Settings
=@ Vo
$> Input Variables
8) Output Variables

@ 1R Management

TTR {Local): A 4513
TTR (Total): j [ 4573
= 101

o Others Timings Management

GAP: Gap Update Factor: f [ 10
TSL: Slot time: & [ 840
TROY: Ready time: [E| 3
TQUE: Quiet Time: Lalfj iy
o Calculated Timing -

Tid1: Time Idle 1: & 5
Tid2: Time idle 2: Pl
o Profibus Cycle:

Profibus Cycle: f 152
Recommended Profibus Cycle: 152

thits

thits

tbits

thits

thits

thits.

thits

Version 1.00.00

& Error Management —

Token Retry Limit: 3

Token Error Limit: 4

Message Retry Limit: 1

Response Error Limit: 15

MIN_TSOR: Smallest Station [ thits
MAX_TSDR: Largest Station: f [ 400 thits
TSET: Setup Time: e [ 9 thits
o Devices Watchdog -

Default Devices Watchdog: f [ 780 ms
Minimum Devices Watchdog: f goh ms

e (o back to the menu “Basic Settings” and select the Baudrate 500kBaud.

af PRM Master Configuration
..o General Settings
[ Profibus Master Configuration
& Basic Settings
& Advanced Settings
& 10 Scanning
@f Profibus Devices
& # 19 Micropilot_5x_from_GSD
...=% DPVI Settings
f Profibus Settings
=@ 1o
%’ Input Variables
... 42 Output Variables

o Profibus Basic Settings -

Baud Rate:

T3: Profibus Station Address:

HSA: Highest Station Address:

e Save the changes by clicking on the button “Apply”.

Cancel

| |

sopy || Heb

oisis

=> The parameter “Default Devices Watchdog” has now the value 760ms at 500kBaud.
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3.3 Mapping of Process Values and Status to Control Strategy
3.3.1 PRM Library

The installation of the library “PRM library V1.0" is required in order to start the PRM. This library can be
found on the PROFIBUS Remote Master CD-ROM.

e (lick on the menu “Tools=>Types Library Manager...".
fey| File Edit View Services Build PLC Debug Window

GxES | ¥ Project Browser Alt+1
[E' s & 0@ SR = —F |  Hardware Catalog Alt+2
DTM Erowser - i onpes Li b;ary Brolf.\r:er i:t+i
1 erator Screen Libra t+
{3 HastPC = 2
E‘[P < 10.126.105.30 » BMEPSE  Search / Replace Alt+5
%__ﬂ.; Remote Bus =
E%_E Distributed Bus Diagnostic Viewer Alt+6
Bl <Modbus:10.1%6.1  PIC Screen Alt+7
] <PRMGAEWA o aple Window Alt+8
+ Data Editor Alt+9
v DTM Browser Alt+Shift+1
Bookmarks Alt+Shift+2
Trending tool
Convert Partially ...
Metwork Inspector
| = Types Library Manager...

Menimet Demmmnr

e Open the library “Libset V8.1" and check if the library “Profibus” is installed.
] Types Library Manager

A Tpes Fra T

Mame A
|~ <Appication>

| =-E5 <Libset VB.1>

) Baselb

] Commurication

1 CONT CTL

Custom Lib
Diagnostics

1 1/O Management
1 MotionFunctionBlock

| B 1 G By B B

om.
1 UniyLL984
<Catalog:

|

)
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3.3.2 Project compilation

e (lick on the menu “Tools—>Project Settings”.
}E File Edit View Services EToo!s Build PLC Debug Window

5 45 % 2 v Project Browser Alt+l
AEEE j
§ Hardware Catalo Alt+2
(=X & B R = | 9
DTM Browser I3 Types Library Browser Alt+3
£y FostPC Operator Screen Library Alt+4
B- W < 10.125.105.30 > BMEPS§  Search / Replace Alt+5
----- h Remote Bus
E| %_m Distributed Bus Diagnostic Viewer Alt+6
<Modbus:10.126.1  PLC Screen Alt+7
El <Prm Gatena| b Window Ale+8
+ Data Editor Alt+9
« DTM Browser Alt+Shift+1
Bookmarks Alt+5Shift+2

Trending tool
Convert Partially ...

Metwork Inspector

Types Library Manager...

Project Browser

> Customize
%a Structural view

55 Project Options...

7, Sy fonfguration | ETTI

e Select the option “Allow dynamic arrays”.

Project Settings
= oSt . FoEE AR
£ General llow leading digits =
Management of build messages
Buld sl Character set Standard
Project entosaving an dovroad Alow ussge of EBOOL edge "
-~ PLE smbsisd dats Ao INT/DINT in place of SNY_BIT I3
~PLC diagnastics Allow bit extraction of INT, WORD and BYTE  [#
- PLC behaviour )
Path Directly ispresented array variables r
Time B dimanic snaps NV_ARREY 000 7]
Corfiguration Disable artay sioe compatiblty chack &
Variables Enable f2st scanning for trending [
i Program
Force references inlialization 2

= Operstor Scresns
- Cantralled Screen
Last opered sereen

% mpot [ Ewpot 9 Resetdl [ ok ][ ey ][ Concel | [ Hep

e Compile the project by clicking on the menu “Build->Rebuild All Project”.
H File Edit View Services Tools fBuild PLC Debug Window
=== | ' | Wy o  Analyze Ctrl+ Shift+B

| " Analyze Proj
@|l§i£’§&1 ',—_.—<>|-|—:>> .IL@ nalyze Project

ot

Build Changes Ctrl+B

[=® Rebuild All Project
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e Once the project compiled, the DTMs used in the DTM browser view have their structure

added in the "variables. (Variables & FB instances menu)
Variables | DOT Types I Function Blocks | DFB Typesl

Fitter
L‘."ﬂg Name E] |'
| Name Type -
580 JEPoE, T OMEPSE ECPU
| A5 @ Micropiot_FMRAx_P_AA300Z | T_Micropilot_FMRSx_P_AAIO0Z
| A5 @ MOD_COM_1 | T_M_CRA EXT_IN
| - o5 @ PRM Gateway | T_PRM_Gateway

3.3.3 PRM Function block configuration

3.3.3.1 PRM Function block import

e Inthe Project Browser view, create a new section by clicking on the menu
“Program->Tasks>MAST->Sections".

Project Browser
g structural view

-y Project

[ [7] Configuration

w[Z] Derived Data Types
1] Derived FB Types
@-[Z] Variables & FB instances
(] Motion

[ [] Communication
By Program

&3 Tasks
B £ MAST
(] Events
1] Animation Tables Import ...

[ 7] Operator Screens
- [k, Documentation

Add User Directory ..
Add Hyperlink ...

e Following message box is displayed. Click on the button “Yes" to continue.

Modification Authorization 23

l-\ Do you confirm the modification 7
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e Enter a section name and choose a language.
New

General | Localization | Condition | Comment |

MName:

-FRM\

Language: Protection:

o —

[ox J[ comcst [ ooy J[ b |

o Inthis example, the section name is “PRM" and the language is “FBD".
o Click on the button “OK" to continue.

o The new section is added in the Project Browser.

S SR Sections

[(Z] Events

e Right-click in the program window and select the menu “FFB Input Assistant...”.

Project Browser (=]
'Ea Structural view
...... 23 Project
(-] Configuration
(] Derived Data Types 30 : : :
(] Derived FB Types e o sm GG G SUSNGYE S s 5 g nem wem e WD Wem e
[]D Variables & FB instances ﬁifitf Ctrl+V
() Motion
- [Z] Communication Zoom L2
i Data Selection... Cirl+D
“ FFB Input Assistant...
ﬂ ... . ... ..|®R Subroutine
SR Sections = Link F6
Q @
,-_ (3 Events - - Pin negation

e The window Function Input Assistant is displayed.
Click on the button “...".

N Function Input Assistant
Instance -5
Protatype
Name Type no.  Comment Ertry field
Add Fin Remave Pinls) Help On Type
Special Assistart [ ok ] [ cancel | [ Hep |

A
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. u n . u (4
o Select the function block “PRM_MGT_M" and click on the button “OK”.
Function Input Assistant : FFB Type Selection
PRM_HGT I -
Function and Funation Block types
Name [=] [ [EF WEFB [¥IDFB
Libraries/Families = - Com - R/W Rights of Referenced Variable |~
(3 <Application> It | M340 - Adar... | [
=-£9 <Libset V3.1> I | Premium - A |
[Q Base Lib
a: L L. —
-3 CONT_CTL I: | B Premium - P |1 E
(3 Custom Lib = ||| =@ PRM_MGT @ <DFB> Quartum - P__. | [
[ Diagnostic: |t 4k RDIAG_M <DFE M340-Rea... Il
{3 1/0 Mznagement |&-{F ROIAG_P <DFB> Premium - R... |1
[ MotionFunctionBlock |-k ROIAGQ <DFB> Quartum - R... | =
2 Motion |- RDREC_M <DFB> M340-Rea... | I
-0 Obsolete Lib | B ik RDREC_P <DFB> Premium - R. |
&5 Profibus | B 4} RDREC_Q <DFB> Quartum - R... | [
£ FRM | Bk SYCFR_M <DFB> M340 - Sen [
£ Safety L 4 SYCFR P <DFB> Premium - S... |/ i
==
A
e The Function Input Assistant displays the chosen function block. Click on the button “OK" to
continue.
=9 Function Input Assistant
FFE bype PRM_MGT_M = |;|
Instance FRM_MGT_M_0 - J
Prototype:
Name Type no. Comment Entry field -
B3 <nputs>
& REQ.. | BOOL 1 Request to read the P..
| : -4 RET.. | BOOL 4 Request to retry to sta. =
| @ MAS.. [T PRM_INFOM (2 |Cc jication path t
@ MAS.. | T_PRM_IN IS PRM status, must be ...
£ <outputs>
-4 VALID | BOOL 1 Read completed, data.
& BUSY | BOOL 2 Command in progress....
& ERR BOOL ) PRM not linked with t -
Ell 1 ] »
£dd Pin Remove Pinls)
Special Assistant [ ok | [ caesl | [ Hep |
A
e Left-click in the program window. This will import the function block.

PRM MGT M 0

PRM_MGT_|

REQ_FSTS
MASTER_INFO
MASTER_STS
RETRY

M

VALID
BUSY
ERROR
STOP
FSTS
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3.3.3.2 PRM Function Block mandatory variables assignment

The structures “MASTER_INFO" and “MASTER_STS" must be assigned in order to get cyclic
communication between the PRM Gateway and the devices.

e MASTER INFO structure
o Double-click on the “MASTER_INFQ" variable.
The edit bar is displayed on the function block.

PRM _MGT M 0

PRM_MGT_M
—|REQ_FSTS VALID

—MAS IERK_S 13
—|RETRY

o Create the variable structure “PRM_masterInfo” and click on the green check box.
PRM_MGT_M_0 '

1
PRM_MGT_M

—||REQ_FSTS VALID

PRM_masterinfo
—IMAS ITER_S 1S
—|IRETRY

o Confirmation window is displayed. Click on the green check box.
Create variable?
Mame: SN ER oG Type: T_PRM_INFO_M = E& 3]

o The structure “PRM_masterinfo” is assigned to the PRM function block.

PRM_MGT_M 0
PRM_MGT_M
: —|REQ_FSTS VALID|—
- PRM_masterinfo—{|[MASTER_INFO BUSY|—
—|MASTER_STS ERROR|—
—|[RETRY STOP[—
FSTS—
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o The structure “PRM_masterinfo” must be initialized.
In the Project Browser, click on the menu “Variables & FB instances->Derived

variables”.
&3, Variables & FB

instances

Elementary Variables
Device DOT Variables
10 Derived Variables
Elementary FE Instances
Derived FB Instances

The structure “PRM_masterinfo” is displayed.

Configure all attributes according to the network configuration.

Variables | DOT Types I Function Block:

5 I DFB Typesi

Fitter

& Module_number
@ Channel_number
& P4
&IP3
& IF2
& P

MASTER_STS structure
O

Double-click on the MASTER _STS variable.

Comment

Rack number of the Ethemet module linked to the PRM
Position of Ethemet module in the Rack

Channel number of the Ethemet port into the Ethemet module
Most significant byte of IP address of the PRM

Least significant byte of IP address of the PRM

The edit bar is displayed on the function block. Click on the button “...".
PRM_MGT_M_0 '

PRM_masterinfo—

AMASTCD OTO

CDDM

PRM_MGT_M
REQ_FSTS VALID|—
MASTER_INFO BUSY|—

RE IRY

S 10

FSTS
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o Assign the attribute “Inputs” of the structure “PRM_Gateway” and click on the button
"OK" to close the windows. This structure has been created automatically when the
DTM has been inserted in the DTM project.

FBD-Editor : Instance Selection ==

PRM_Gatewsy Inputs

Variables | Function Biocks |
[T (] Mame ) F

MName Type = Commert *  Time stamping ~|=
% @ BMEPSE_ECPU T_BMEPS3_ECPU
@ MOD_COM_1 T_M_CRA_EXT_IN
T_PRM_Gateway
BOOL Global Freshness
Fr Obe:

] Inside structure

3! DI0O.
T_PRM_OUT CTRL Bes for DIO O
=@ PRM_masternfo T_PRM_INFO_M

S ) el

o Assigned variables.

PRM MGT M 0
1
PRM_MGT_M

—|REQ_FSTS VALIDf—
PRM_masterinfo—|MASTER_INFO BUSY[—
PRM_Gateway.Inputs—|MASTER_STS ERROR|—
: —|RETRY STOP|I—
FSTS|—

3.3.3.3 PRM Function Block optional variables assignment

e The other variables can be assigned following the same steps as for the MASTER_INFO
structure (see previous chapter).

PRM_MGT_M_0
PRM_MGT_M
request_status—|REQ_FSTS VALID —valid
PRM_masterinfo—|MASTER_INFO BUSY|[—busy
PRM_Gateway.Inputs—|[MASTER_STS ERROR|—error
- retry—|RETRY STOP|—stop
FSTS[—FSTS
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3.3.4 Animation tables configuration

Animation tables are used to display variables values in online mode. The following part explains how to
configure one animation for the PRM function block and one for the PRODFIBUS devices.

3.3.4.1 Animation table PRM_FB

¢ Inthe Project Browser, right-click on the menu “Animation Tables” and select the menu “New
Animation Table".

- Program

{3, Tasks
B 31, MAST

=] a, Sections

- [l PRM
D SR Sections
Events
—[[Z] Timer Events
[‘_‘| Ifo Events
-@

m, Docnmentatlon

Export
Import

e Enter a name for the animation table and click on the button “OK".

MNew Aniration Table @
Narne: Functional module:
IPHM_FEl I <Mones

Cammert:

Extended Sting Animation
Mumber of animated characters: 100 [range: 20-300)

[ Temporary Table

Include in upload infa

Ok

] [ Cancel ]PRM

e The created animation table is added in the Project Browser.

EI ----------- £5 Animation Tables
o ENRERD @ PRM_FB

e Double-click on the animation table “PRM_FB".
Following window is displayed.

l Modification ” Force l - » % i

MName - Value Type - Commert
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e Double-click in the field “Name “in order to display the button “...".

| Modification ” Force J % i

MName - Walue Type - Commert

bl T

e Select the variables of the PRM function block and click on the button “OK".

Animation Table : Instance Selection (=3
busy 3
Vaniables | Function Blocks|
Name (=] [ [Z|EDT [¥]DDT|[]10DDT  [C] Device DOT

Time stamping |

o
g
El
3
a
-
4

e Selected variables are added in the animation table.

Project Browser 1=
%a Ehaachir e | Modification ” Force I % [
3 Project Name - Value Type et Comment

C‘!, Configuration ¥ request_status BOOL

3] Derived Data Types % busy BOOL

2] Derived FB Types & stop BOOL

C‘!, Variables & FB instances & emor BOOL

31 Motion & valid BOOL

2] communication & ety BOOL

C‘!, Program @ PRM_masterinfo T_PRM_INFO_M

£5 Animation Tables @ PRM_Gateway T_PRM_Gateway

[m] PRM_FB 3] T_PRM_FSTS
(1 operatorscreens - ]

3.3.4.2 Animation table PROFIBUS DP_devices

e Inthe Project Browser, right-click on the menu “Animation Tables” and select the menu “New

Animation Table".
: [2, Program H | & stop

B alid

%= | Animation Table:
..... [aT] PRM_FB Mew Animation Table

(] Operator Screen
[#.,, Documentation
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e Enter a name for the animation table and click on the button “OK".

Mew Animaticn Table @
Name: Functional module:
PROFIBUS_DP_devices <Monex

Comment:

Extended Sking Animation
Mumber of animated characters: 100 [range: 20-300)

[T] Temparary T able
Include in wpload info

0K ] [ Cancel ]

e The created animation table is added in the Project Browser.
Bz £5 Animation Tables

-.[af] PRM_FB
S B FPROFIBUS_DP_devices

e Double-click on the animation table “PROFIBUS_DP_devices".
Following window is displayed.

l Modification ” Force l - » % i

MName - Value Type - Commert

e Double-click on the field “Name “in order to display the button “...".
l Maodification l l Force ] : . % i

Name - Value Type - Comment

|

e Select the variable “Micropilot_FMR5x" and click on the button “OK".

Animation Table : Instance Selection @

Micropilot_FMR%&¢_P_AAIODZ -

Varigbles | Function Blocks

[[1epT [CJooT [C]10DDT  [¥] Device DDT

Type - Comment - Tim... -
T_BMEP58_ECPU

@ T Micropilot_ FMRE¢ P AA300Z | | ]
@ MOD_COM_1 | T_M_CRA_EXT_IN _
- @ PRM_Gateway T_PRM_Gateway
e Selected variable is added in the animation table.
Project Browser =]

%a R Modification Foice 3 ] y % @

&3 Project o~ Name - Value Type -
[ configuration | @@ Micropilot_FMR%_P_AA3007 T_Micropilot_FMR%_P_AA30DZ

(] Derived Data Types L3
D Derived FB Types
(] variables & FB instances
(] Motion
D Communication
(2] Program
£5 Animation Tables
; PRM_FB

m
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3.4 Commissioning of the Control Project

3.4.1 Project compilation

e Select the menu “Build>Rebuild All Project”.

H File Edit Wiew Services Tools [Build PLC Debug Window
B=EES | | 3 Analyze Ctrl+Shift+B

R R ERBRS 4 » 0 5 ey ripecd.
[£¥ Build Changes Ctrl+B

‘DTM Browser
r /2 Rebuild All Project

e Following Message box is displayed.

Click on the button “Yes” to continue.
List of modified sections 23]

PRt

Confirm build application 7

il E nable option "Display list of modified
zections befare build”

e Following Message box is displayed.

Click on the button “Yes"” to continue.
Rebuild All Project (R

.-”_h\-l You ask for a complete rebuilding of your project instead of generating
¥’ only the modifications...

I'\.
Do you want to continue?

[ Yes ] ’ MNo
e Compilation is succesful.
-’:-I {Rack [\2.140 ) BME XBP 0400} : Generating...
{Rack [y2.130 ] BME XBP 0400} : Linking...

Linking...
Process succeeded : 0 Error(s]) , 0 Yarning(s)

Search/Replace f

[+ [*1]y Rebuild All Project /i, Import/export  },  Useremors  y  FDTlogevent  j

SD01463S/04/EN/01.15 68/96



Scrérgﬁigﬁf Endress+Hauser (21

People for Process Automation

Integration Tutorial SEO1 Version 1.00.00

3.4.2 Project download

3.4.2.1 Project download in PLC

e Select the menu “PLC>Connect” in the tool bar.
File Edit View Services Tools Build [PLC Debug Window Help

eSS | 2 4 B | Connect Ctri+K
: Set Address...

e Once connected, select the menu “PLC>Transfer Project to PLC".
File Edit View Services Tools Build Debug Window Help
BedsES | 5

mHmE|a-

B2 | i) Disconngct Chrl+K

5 Transfer Project to PLC Ctrl+L

S.“]]T[ansfer Project from PLC Ctrl+Shift+L

e Following Message Box is displayed. Select the option “PLC Run after Transfer” if needed.
Transfer Project to PLC
FC Project Overwiitten PLC Project
Mame: Fraject Mame: Project
Wersion: 004 Yersion: 0.0.8
LastBuld:  02/09/201514:41:57 LastBuld  02/03/2015 12.20:34
FLE Run after Transfer
[ Transfer ] [ Cancel
e Following Message Box is displayed. Confirm by clicking on the button “"OK".
Stop
¥ PLC Project:
r@ Na:ne: Project
Version: 0.0.5
Last Build: 02/09/2015 12:20:34
Coenfirm Step on this Project?
oK Cancel
e Following Message Box is displayed. Confirm by clicking on the button “OK".
Run
‘/""\‘ PLC Project:
© Mame: Project
Version: 0.0.9
Last Build: 02/09/2015 14:41:57
Confirm Run on this Project?
ok | [ Ccancel
SD01463S/04/EN/01.15
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e The PLCisin run mode.
HMI R/W mode JEQUAL UPLOAD INFO OK

3.4.2.2 Configuration download in PRM Gateway

e Connect the Gateway Ethernet cable.
The SF LED is red blinking.

e (Connect the Gateway in Online mode.
Right-click on the PRM Gateway and select the menu “Connect”.

DTM Browser
{3 HostPC
B- [P < 10.126.105.30 > BMEP58_ECPU

----- —nﬂ Remote Bus
EI %_E Distributed Bus

2 < PRM_Gateway:

Del

Load data from device

Store data to device

Once in Online mode, right-click on the PRM Gateway and select the menu “Store data to
device”.
DTM Browser

{3 Host PC

=] ¢ Ea = 10.126.105.30 > BMEP58_ECPU
----- 3@ Remote Bus
E| %_E Distributed Bus

Elwk-

]
e, ' < PRM_Gateway:19 > Micropil pen
Add...
Delete Del

Field bus discovery

Disconnect

Load data from device

Store data to device

e Following Message Box is displayed. Click on the button “OK” to continue.
.Duwnload'-Conﬁgma.i;l.(m Command |-£|

o

F PRM will need to reboot after download to take into account the new
L configuration file, The PRM Gateway DTM will be disconnected at the
end of the downlead sequence. Would you like to continue?

ves | [ Mo
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e Following Message Box is displayed. Click on the button “OK" to continue.
Download Configuration Cormrmand [EI

e

[ Configuration has been transferred succesfully to the PRM. PRM will
W' reboot to take into account this new configuration.

e After the PRM Gateway reboot, the SF LED is OFF and the RUN/STOP LED is green.
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3.5 Monitoring of Process Values and Status Information
3.5.1 Diagnostics via Web Browser

e Open a web browser and enter the IP PLC IP address.
In this example, the PLCIP address is 10.126.105.30.

e )| @ http:/10126.105.30

3.5.1.1 PLC & Network Diagnostics

e The M580 Standard Web page is displayed.
This page Tag shows:
o PLCstatus.
o Version Info.
o Network configuration.

i M580 Standard Web

BMEP582040

Home Diagnostics

Status Summary

[ ) CARD_ERR
CARD_ACT
B oo status B network sTATuS DOWN LOAD
Service Status Version Info

&  DHCP Server Enabled Exec. Version 2
&  FDR Server Enabled Web Server Version 1.0
@&  Access Control Disabled Web Site Version 2.0
€  Scanner Stalus Working Properly CIP Version 1.0
@ NIP Status Disabled
FDR Usage 0.32%

CPU Summary Network Info.

Pt BME P58 2040 IP Address 10.126.105.30
p— RUN Subnet Address 255.255.252.0
. Gateway Address  10.126.104.1
Scan Time 3Ims
MAC Address 0080F4113BC8

Logged In Yes

. Host Name BMEP582040
CPU Exec. Version 2.01
Unity Program Project

3.5.1.2 1/0 Scanner

e C(lick on the Tag “Diagnostics” and select the menu “I/0 Scanner”.

Version 1.00.00
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In this example, two devices have been scanned:
o The PRM Gateway with IP address 10.126.105.33.

o The CRA module with IP address 10.126.105.32.
I M580 Standard Web

BMEP582040

Home Diagnostics
IO Scanner
Module -
=i Scanner Status Connection Statistics
Status Summary € Operational Total Transmissions Sent 565099
Number of Valid Connections 2
Performance

Port Statistics

N /| ./ (S N D N [ N [ o

2e= - > OJOCOCOCO0COCOOCOCOOOMEOMOEOOEC/IC|y -

QoS

E

Q8

&

S N | | DR
;!d::::::y N D Not Configured @ Unscanned Scanned Fault

Alarm Viewer

3.5.1.3 PROFIBUS Diagnostics
3.5.1.3.1 PRM Gateway

e Inthe DTM Browser view, right-click on the DTM “PRM_Gateway” and select the menu “Device

menu->Diagnosis”.
3 HostPC
Bl ¥ < 10.126.105.30 > BMEPSS_ECPU

Rﬂ Remote Bus
E-38 Distributed Bus
Bage s
“w[F <PRM Gatew|  Open
Add...
Delete Del
Field bus discovery

Sort by address

Connect

Disconnect

Load data from device

Store data to device

Paste
Device menu L3

Properties ALT+Enter

13
Print device
Zoom in Obsen.

e Select the field “Profibus Master”.
The PRM Gateway has the status “Operate”.
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=8 PRM Gateway - Diagnostic

S PRM

i L.&% PRM Advanced diagnostic
PLEC Connection

[ 1 Profibus Master|

=@ Profibus Devices
@ 19 Micropilot_5x_from_GSD

Version 1.00.00

&) Profibus Master -

Prafibus M aster State [cyclic): OPERATE

Pending Acyclic Requests: 0
Led of the Prafibus Master node

@ Bus fault detected

(@ Profibus master iz in OPERATE mode

(r Prafibus master iz in CLEAR made

(1 Profibuz master iz in STOP mode

e Select the field “Profibus Advances Diagnostics” to get more details.

=-= PRM Gateway - Diagnostic
&b PRM
. PRM Advanced diagnostic
PLC Connection
Profibus Master
Profibus Advanced Diagnostic
Profibus Devices
@ 19 Micropilot_5x_from_GSD
..... & Advanced Diagnostic
----- & /0 Values

€ Profibus Advanced Diaghostic

Parameter W alue

LaAN Offline Errors 0
Confirmation Message Received EE33
Indication Meszage Received 1]
Confimation Or Indication Meszage Enors 1
Current Time Token |z Held [Thits] 1280
inimurn Time Taoken \Was Held [Thits) 0
Prafibugz Command Register 225
Profibug Status Register 1]
Profibus Stack Yersion 01.04
Frofibuz Stack |dentification EEO4

=z ateway Block Statistics

1/0 Cycle completed E177
DP Slave Communication Emors 1]
DF Slave Disconnection i}
Current Master 1/0 Cycle Time(ps) 000
I axirnurmn M aster 170 Cycle Time(ps) 000

“FOIL Layer Statistice™
FDL Positive awnsers 0
FOL Megative awnsers 1

wessEhSPC2 Profibus Contraller Statistics™ ==
Inwalid Request Length Erars

FIFD Overflow Erors

Received Overun Emors

Double Token Ermors

Meszage Fail Or Mo Fesponse From Destination
General Network Errars [Syn, CC...]

Metwork Time Out Ermors

Station Higher Than HSA Detected

Duplicate Station Detected

cooocooooooo

Module Unable To Pass The Token
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3.5.1.3.2 PROFIBUS devices

Version 1.00.00

e Select the field “Profibus Devices” to display all available status.
In this example, the Micropilot is successfully connected to the PRM Gateway.

== PRM Gateway - Diagnostic

& PRM
& PRM Advanced diagnostic
@ PLC Connection
@ Profibus Master
& Profibus Advanced Diagnostic
.- @ 19 Micropilot_5x_from_G5D
& Advanced Diagnostic
& [0 Values

& Frofibus Devices

Led of the Profibus Devices node (Applies also for each device node)
@ No data exchange (Profibus STOP state or device not corfigured)
@ Connection failed with at least one device

@ Communication is OK and there is no diagnostic asked by a device

() Diagnostic asked by at least one device

@ Connection failed and diagnostic asked by at least one device

e Select the field “Micropilot_5x_from_GSD" to get device diagnostics.

=-- & PRM Gateway - Diagnostic

5. & PRM

.= PRM Advanced diagnostic

@ PLC Connection

@ Profibus Master

.= Profibus Advanced Diagnostic

=@ Profibus Devices

Y5 icropon 5 from G5)

& Advanced Diagnostic
= [/0 Values

) Device Diagnostic Information

e Select the field “Advanced Diagnostic” to get more details.

== PRM Gateway - Diagnostic
& PRM
- PRM Advanced diagnostic
@ PLC Connection
@ Profibus Master
L. Profibus Advanced Diagnostic
- Profibus Devices
& @ 19 Micropilat_5x from_GSD

L 4 Advanced Diagnostic

.o 1/0 Values

Ident Humber 0x1553 Master Address 1
Master Lock Slave Deactivated (@] Ext Diags Overflaw ()
Parameter Fault -] Reserved @ Reserved [
Invalid Slave Response (5] Sync Mode (9] Reserved [
Mot supported (&) Freeze Mode (@] Reserved @
Extend Diag @ “watchdog On Q@ Reserved 1]
Configuration Fault @ Slave Device Q Reserved ]
Station Mot Ready (@] Static Diag (@] Reserved @)
Station Mot Existent O Re-parameterization needed (@) Reserved )
&) Extended Parameters —
<G5D_Diag_Decode>
<DiagAlarm Slot = "0" Specifier = "No further differentiation™ Type = "reser
<RawBuffer Value = ""/>
</Diaghlarmy>
</G5D_Diag_Decode>
@ Advanced Diagnostic
General Statistics
R¥ Length ES Designation N,
T Length 28 Error N
Status oK Event 1
Ext Error il Diag Event 0
Diagnostics From Slave Parameters Ta Slave [rata

Status] 000 Stalion Status 083 @ Extended Diagnostic
‘widogFact! [ () Set Parameter
e == ‘WenaFact? 18 () Check 10 Configuration
logF ack
Status3 0x00 T
ReadyTime 1
Master Address 1 Ident Mumber 0x1553
Group ID 1]
Ident Nurber 0x1559
Param Len 5
Biale 9 Check Len 48

e Select the menu “I/0 Values” to display input/output buffers content.
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== PRM Gateway - Diagnostic

&% PRM

 L.e PRM Advanced diagnostic
@ PLC Connection

@ Profibus Master

& Profibus Advanced Diagnostic
Profibus Devices

Q@ 19 Micropilot_Sx_from_G5D
& Advanced Diagnestic

o [N

Version 1.00.00

€ Input Data [Bytes):

Offzet 0 1 2 3 4 5 E 7
] 42 89 9 bbb 80 42 T 9o
003 bb 80 42 % 9 bb 80 42
01 92 S bb 80 42 %= Gz bb
024 a0 42 9 S bb 80 00 a0
032 oo 80 00 B0 00 80 H @

o Output Data [Bytes):

Offsat 0 1 23 A |5 B[ 7
oan oo 00 00 00 OO0 0O 00 oo
003 oo 00 00 00 OO0 00O 00 oo
e oo o0 00 00 00 00 00 0o
024 oo 00 00 00O # O OH O OHOO#
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3.5.2 Online monitoring

e Inthe Project Browser, open the Animation table “PROFIBUS_DP_devices".
£-+3 Animation Tables
[7] PRM_FB

PROFIBUS_DP_devices

e Expand the data structure “Micropilot_5x_from_GSD".

MName - Value Type - Comment

T_ :_fr:::rn_
ot T_Micropiot_5_from GSD_N - Analog Inputs
""" & value_analoginput_1 79.3091 REAL

4@ status_analoglnput_1 128 BYTE <€ 4 Bytes value (REAL)
= B AL_OUT_Analog_input_IN_2 ARRAY[D. 4] OF BYTE 1 Byte status
----- @ AL OUT Analog_Input_IN_2{0] 66 BYTE .

----- & AlOUT_Analog_Input_IN_2[1] 158 BYTE i

@ ALOUT_Analog_Input_IN_2[2] 158 BYTE

----- ® ALOUT Analog_input_IN_2{3) 67 BYTE Analog Inputs
----- & AL OUT Analog_Input_IN_24] 128 BYTE 4 Bytes value (Byte)

w8 ALOUT Analog_lnput_IN_3 ARRAY[0. 4] OF BYTE

5B ALOUT Analog_lnput_IN_4 ARRAYD. 4] OF BYTE 1 Byte status

5 B ALOUT_Analog_lnput_IN_5 ARRAYI0.4] OF BYTE

& B ALOUT_Analog_lnput_IN_6 ARRAYI0.4] OF BYTE

& B DI_OUT_Digital_input_IN_7 ARRAY0..1] OF BYTE

& B DI_OUT_Digital_input_IN_8 ARRAY0..1] OF BYTE

& B DI_OUT_Digital_input_IN_S ARRAY0..1] OF BYTE

& B DI_OUT Digtal_nput_IN_10 ARRAY0..1] OF BYTE

w- B Freel ARRAY0..1] OF BYTE

o @ Outputs T Micropilot_&_from_GsD_ouT Analog Outputs

----- & value_analogOutput_1 0.0 REAL ( 4 Bytes value (REAL)

-~ 4 status_analogOutput_1 0 BYTE 1 Bvte stat

"B AO_SP_Analog_Output_OUT_12 ARRAY[D.4] OF BYTE yte status
----- @ A0_SP_Analog_Output_OUT_12[0] 0 BYTE |
----- @ A0_SP_Analog_Output_OUT_12[1] 0 BYTE
----- & AO_SP_Analog_Output_OUT_12[2] 0 BYTE Analog Outputs
----- @ AD_SP_Analog_Output_OUT_12[3] 0 BYTE ~~-_ 4 Bytes value (Byte)
----- @ A0_SP_Analog_Output_OUT_12[4] 0 BYTE

1 Byte status

- B AD_SP_Analog_Output_OUT_13 ARRAY[D. 4] OF BYTE
- B AD_SP_Analog_Output_OUT_14 ARRAY[D. 4] OF BYTE
- B DO_SP_Digital_Output_OUT_18 ARRAY[D.1] OF BYTE
- B DO_SP_Digital_Output_OUT_16 ARRAY[D.1] OF BYTE
- B DO_SP_Digital_Output_OUT_17 ARRAY[D.1] OF BYTE
- B DO_SP_Digital_Output_OUT_18 ARRAY[D.1] OF BYTE

e To edit outputs values/status, click at first on the button “Modifiation”.

MName - Value Type -

E-@ Micropilat_%e_from_GSD | | T_Micropilot_fx_from_GSD
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e Editable outputs fields become bold.

@@ Outputs |
@ value_analogOutput_1 |00

& status_analogOutput_1
- B AD_SP Analag Output OUT 12
& AD_SP_Analog_Output_QUT_12[0] |
& AD_SP_Analog_Output_QUT_12[1] |
L] AD_SP_Analog_Output_OUT_12[2] |
@& AD_SP_Analog_Output_OQUT_12[3] |
& A0
AD
AD

=

ooooos

_SP_Analog_Output_OUT_12[4] |
P_Analog_Output_COUT_13
P_Analog_Output_OUT_14
DO _SP_Digital_Output_OUT_15
DO _SP_Digital_Output_OUT_16
DO _SP_Digital_Output_OUT_17
DO_SP_Digital_Output_QUT_18

_S
S

(1B B
[

Version 1.00.00

T_Micropilot_5x_from_GSD_OUT
REAL

BYTE

ARRAYI0..4] OF BYTE

Output Variables

ARRAYTD..4] OF BYTE
ARRAYTD..4] OF BYTE
ARRAYID..11OF BYTE
ARRAYTD..11 OF BYTE
ARRAYI0..11OF BYTE
ARRAYI0..1]OF BYTE

e Edit the requested variable value and status.

For example, the analog output:

=@ Outputs
# value_analogOutput_1
status_analogOutput_1

e (lick on the button “Force” to validate.

[ todification ” Faorce I

. MName -
=@ Micropilot_5x¢_from_GSD

e Output values are written on the bus.
=& PRM Gateway - Diagnostic
Ei-= PRM

i i.sb PRM Advanced diagnostic
@ PLC Connection
B@ Profibus Master
b & Profibus Advanced Diagnostic
a@ Profibus Devices

2@ 19 Micropilat_5x_from_GSD
..o Advanced Diagnastic

470 Vaiuc

T_Micropilot_Sx_from_GSD_OUT

2 [

Value Type -

T_Micropilot_f_from_GSD

L. W} utput D1ata [Bytes]:

Offset 1] 1 2 3 4 5 3 7
0og N 44 e cod 20 00 00 00
nog op 00 00 00 00 00 00 00
e op 00 00 00 00 00 OO 00
024 op 0o 0o 0o o# # OB OB
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4 Advanced Integration

The Advanced Integration workflow is identical as the Basic Integration except for the Field Network and
Device Configuration, in which DTMs are used instead of GSDs.

4.1 Field Network configuration with DTM
4.1.1 Device DTMs Library

¢ Install the Endress+Hauser Profibus DTM Library V2.41.00.

e Open the Hardware Catalog by clicking on the menu “Tools->Hardware Catalog”.
File Edit View Services fToo!s Build PLC Debug Window

2= | 5z ¥ | v Project Browser Alt+1
& M e |(3‘ = i Hardware Catalog Alt+2
o . onpes Li brsary Broliuiv:er i:h—j
erator Screen Libra t+

| & Hoster = i

o Click on the button “Update” to update the DTM catalog database.

Hardware Catalog
(= ‘:o*" devices Device Type Vendor Version Date

& Device types ALTIVART1 Revision ... Device Schneider Electric 27 |

- Vendors ALTIVART1 Revision .. Device Schneider Electric 33
b= Groups 'l EME AHI 0812 Gateway Schneider Electric 10430 | 20140523
& Frotocols [ BMEAHD 0412 Gateway Schneider Electic | 1.0.49.0 | 20140523
i BMENOCD301 Communication Schneider Electric 15130 | 20141118

E_ BMENOCO301 ffrom ... Device Schneider Electric 1.1
| & BMEMNOCD311 Communication Schneider Electric 15130 | 20141118

E_ BMENOCO311 ffrom ... Device Schneider Electric 1.1

E EMEPEBWED from E... Device Schneider Electric 13

[ oo

4[4 v\ EIOBUs } PLChus # DTM catalog [

o Following Message Box is displayed.

Click on the button “Yes".
Unity Pro XL BN
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o Endress+Hauser device DTMs are now installed.

Hardware Catalog
! Device types - Device Type Vendor Version Date
- Vendors Fi7 Dehabar 5/xMexde / PA/V20.V2.2 Device Endress+Hauser 151582... | 201503-18
. Advanced Micro Cortrols| V| Detapiot M/ FMBSc/ PA/ FW 1.00.... Device Endress+Hauser | 15.152.. | 20150318
- AGM Blectronics, Inc U1l Cermbar S/ PMxxx /PA/V11 Device Endress+Hauser | 15.152 20150318
Beckhoff Automation Vil Dekapiot 5/ DB &/ PA/ V1.0V Device Endress+Hauser | 15.152... | 20150318
- Endress + Hauser Vi  Deltapilot 5/ DB 5/ PA/ V13 Device Endress=Hauser | 15.152.... | 20150318
- Endress+Hauser Vil Detapiot S / FEB 24/ PA/V20..V22 Device Endress+Hauser | 15.152... | 20150318
-+ HMS Industrial Networks || ¥} Deltapilot S / FMB 70/ PA/ FW 4.01.... Device Endress+Hauser | 15.152.. | 20150319
- Rockwell Automation Ui Dekapilot 5/ FMB70/ PA / V4 D00 Device Endress+Hauser | 15.152 20150318
Roclkwel Automation - R k7 Gammapilot M/ FMG 60 / PA/V1.02... Device Endress+Hauser | 15.152... | 20150318
- Rockwell Automation/En k77 g ot M/ FMG 60/ PA/ Vixx Device Endress=Hauser | 15.152.... | 20150318
- Rockwell Atomation/Re L3l Temp / TMT 184 / PA/V1.0..1.1 Device Endress+Hauser | 15.152.... | 20150318
£ oy D iTemp /TMT1BA/PA/ VA Device Endress+Hauser | 15.152... | 20150319

[« »[ ¥ E0Bus }, PLCbus } DTM catalog |/

e Allimported device DTMs are reasonably assigned to predefined folders :
o Device types = Devices

Vendors - Endress+Hauser

Groups 2 DTM specific

Groups > Electromechanical Analyser

Groups = Flow

Groups = Level

Groups = Pressure

Groups = Temperature

Protocols = Profibus DPV1

O O O O O O O

4.1.2 Field Device Configuration with DTM
4.1.2.1 New field device

e Inthe DTM browser, right-click on the PRM Gateway DTM and select the menu “Add".
DTM Browser

{53 HostPC

- [Q < 10.126.105.30 > BMEP58_ECPLI
----- %_E Remote Bus
- Dlstrlbuted Bus

A < Modbus:10.126.105.33 > PRM_Gatew

Delete Del

e Select the device DTM “Micropilot/FMR5x/PA/FW1.00.zz/Dev.Rev.1" and click on the button “Add
DTM".
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Add ==
Device Type V..  Version Date  ~

AF  Liquisys M /CLM 2¢3 cond / PA /V2.30..V2.31 Device E..|151523.. | 2015-..
LF  Liquisys M/ CLM 2<3ind / DP / V2.30..V2.31 Device E| 1.5:152.3: | 2015
AF  Liquisys M/ CLM 2x3ind / PA /¥V2.30..V2.31 Device = 1.5.152.3... [ 2015
feH Liquisys M / COM 23 / DP /V2.40..V2.41 Device E..|151523.. | 2015-..
fei Liquisys M / COM 2¢3 / PA / V2.40.. V2 41 Device E:| 1.5:152.3: | 2015
fEH) Liquisys M / CPM 23 / DP /V2.30..v2.31 Device = 1.5.152.3... [ 2015
feH Liquisys M / CPM 23 / PA /V2.30..V2.31 Device E. [151523.. | A5 [5
fE Liquisys M/ CUM 2x3 / DP /V2.30..V2.31 Device E. [151523.. | 2015, (=
fEH) Liquisys M / CUM 23 / PA /V2.30..v2.31 Device = 1.5.152.3... [ 2015
fEH Liquisys M CL /CCM2*3 / DP / 2.30 Device E.. | 151523.. | 2015-..
fi Liquisys M CL / CCM2*3 / PA / 2.30 Device E.:| 1.5:152.3.: | 2015-.
f=ig Micropilot # FMRTx / PA S FW 1.00 2z / Dev Rev. 1 =
LF Micropilot / FMREx / PA/ FW 1.01.22 / Dev.Rev. 2 | Device E..| 150168 | 2014-..

] Micropilot % from GSD) Device E.. | Profile 3.02
A7 Micropilot Il / FMR 2%« / PA / V2.00 Device Eoi| 15115230 [ 2015
fEH Micropilot M / FMR 25¢ / PA / V04.00 Device E.. | 151523.. | 2015-..
fEi Micropilot M / FMR 25 / PA / V5 Device E.:| 1.5:152.3. | 2015
[y Micropilot M ./ FMR 2ec / PA S V1.0¢ Device Eoi| 15115230 [ 2015

L Mi ilet M/ FMR 2 / PA /W2 N DNeviee F 151523 |01 ¥

e Following window is displayed.
Click on the button “Yes" to continue.

e .
Modification Authorization |-E3-

‘E Do you confirm the modification 7

== ]

e Following window is displayed.
Click on the button “OK" to continue.
'Properties of device ==

General | Device information | DTM information | Protocel information |

DTM name management

YN/l cropilot_FMRGx P AAZODZ]

Tag name :

Defautt 1/0 vision management
Default input 1/0 vision
Variable name : Micropilot_FMR5_P_AA3CDZ_IN
Default output /O vision
‘Variable name : Micropilot_ FMRS_P_AAIODZ_OUT

. .

e The Micropilot is inserted in the DTM browser Project structure with the address 0.
[DTM Browser '

{33 HostPC

=-§§ < 10.126.105.30 > BMEPSS_ECPU
3@ Remote Bus
=49 Distributed Bus

B..

% < Modbus:10.126. 105,33 > PRM_Gateway
: 4 < PRM_Gateway:0 = Micropilot_FMR.5x_P_AA3Q0Z
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4.1.2.2 10 modules configuration

e Double-click on the Micropilot DTM.

e This opens the device DTM configuration window in Offline mode.

DTM Browser

=

3 HostPC
E-§§ < 10.125.105.30 > BMEPS8_ECPU
&3 Remote Bus
%% Distributed Bus
Bl <Modbus:10.126,105.33 > PRM_Gateway
2} < PRM_Gateway:0 > Micropilot_FMR5x_P_AA300Z

Version 1.00.00

®  Devicename: Level linearized: 0.0000 %
V Device tag: Distance (9): 0.0000 m
0
Status signal: u Offiine
& B | |4 parameters | g S 9 e
[ Menu / Variable [ value
EHz  Migopilot 5%
P01 Selection ok 2 Yes
PC1 Access status tooling: Maintenance
GO Setup
(3  Diagnostics
B3 Expert
| [ ]
| arofne |

<= Disconnected |

10|

| 2 | [ | UserRole: Planning engineer

1 E Micropilat_F... I

e (lick on the menu “Micropilot 5x=>Expert->Communication>Channel Configuration”.

The default 10 module configuration is already set.
]

@  Device name: FMR5x Level linearized: 0.0000 %
¥ Device tag: FMRSX Distance (9): 0.0000 m
|
Status signak u Offiine
A | [1perameters & & 010
[Menu / Variable [vae [~} Analoginput 1: P |1 [1]): OUT (Analog Input)
EHEZ  Miaopiot Sx Anzloginput 2: AL [2]: OUT (Analog Input)
P Selection ok ?: Yes
P Access status tooling: Maintenanc Analog input 3: Al [3]: OUT (Analog Input)
(3 sewp Anlog input 4 Al [4]: OUT (Analag Input)
[}C3  Diagnostics
BHEF  Expert Analog input 5: Al [5]: OUT (Analog Input)
P01 Locking status: Anlog input 5: Al [6]: OUT (Analog Input)
P01 Access status display: Operator -
-1 Access status tooling: Maintenanci Berck poy & PLLL): OUT (Discrete Tnput)
P01 Enter access code: Discrete input 2: DI [2]: OUT (Discrete Input)
GH3  System =
Discrete input 3: DI [3]: OUT Qiscrete Input) [
F{3  Sensor
3 Output Discrete input % DI [4]: OUT (iscrete Input)
EHZ  Communication =1l Anstog output 1: AG [1]: 5P (Analog Output)
[3  PROFIBUS PA configuration
[ PROFIBUS PAinfo Analog output 2: AQ [2]: 5P (Analog Output)
3 Physical block Analog output 3: AQ [3]: 5P (Analog Qutput)
Ol Channel Configuration
= zlog input 1: AT [1): OUT] Analog output 4: A0 [4]: 5P (analog Output)
P1 Analog input 2: AL[2]: OUT| Discrete output 1: DO [1]: 5P (Digital Output)
PC1 Analog input 3: AL[3]: ouT| -
R i Discrete output 2: DO [2]: 5P (Digital Output)
P1 Analog input 5: AL [5]: ouT| Discrete output 3: DO [3]: 5P (Digital Output)
P1 Analog input 6: AL [5]: ouT| ;
Discrete output 4: DO [4]: 5P (Digital Output) [
P1 Discrete input L DI [1]: oUT|

e This default 10 module configuration can be changed.
In the following example, the module “Al” of slot 1 is replaced by the module “Free Place”,
according to the GSD 10 module definition.

o Select the module “Free Place” and Click on the keyboard button “Enter” to confirm.

SD01463S/04/EN/01.15
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Analog input 1: / ’ Free Place E|
Analog input 2: AT [2]: OUT {Analog Input)
Analog input 3: Al [3]: OUT {Analog Input)
Analog input 4: AT [4]: OUT {Analog Input)

o The new module is successfully inserted.

Analog input 1: ’ Free Place E|
Analog input 2: AT [2]: OUT (Analog Input)
Analog input 3: Al [3]: OUT (Analog Input)
Analog input 4 Al [4]: OUT (Analog Input)

o Close the DTM window.

4.1.2.3 Field Device settings

e Double-click on the PRM_Gateway DTM.
DTM Browser

{33 HostPC
=-i8 < 10.126.105.30 > EMEPS8_ECPU

3@ Remote Bus
=48 Distributed Bus

e The menu “Profibus Devices” is now available in the PRM Master Configuration view.

i PRM Gateway
i Profibus Remote Master Configuration Tool

& Advanced Settings
. o 10 Scanning
E|!rﬂ Profibus Devices
& 0 Micropilot_FMR5x_P_AA300Z

= Profibus Settings
- /0
? Input Variables
$> Qutput Variables

¢ PROFIBUS address / DPV1 Settings/ PROFIBUS Settings/ 10 modules data structure
configuration

The principle is exactly the same as for the GSD integration, described in part 3.2.4.1.3 PROFIBUS
address.
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5 Routed Tool Integration

This chapter describes the main workflow for integration of Schneider Electric system components to the
Endress+Hauser Plant Asset Management (PAM system) by means of Communication DTMs. As a result,
the Endress+Hauser PAM system can access underlying PROFIBUS devices via Schneider Electric Ethernet
backbone for device configuration.

5.1 Schneider Electric “PRM Comm"” DTM configuration

e Start the application FieldCare.

FH

FieldCare

e C(Create a new project.
FieldCare

New i Existing i Hecenti

Connection MultiDirop Paint-ta-Paint SOFTIMG
Wizard
PCF Interface 155 Interface IPC Interface CDI Fxa291 COlUse

&

Mational Inst.

Creates an empty project

Open Cancel |

e Right-click on the Network Tag “Host PC" and select the menu ” Add Device".
Network
Network Tag

%% Add Device...

Launch Wizard...
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e Select the DTM “PRM Comm” and click on the button "OK".

1 Add New Device
Device I " erzioh I Clazs | b arwf acturer I Protocol I
CommD TR PROFIBUS DP41 W4.0.0.9[2011401-17) . Trehing & Himstedt Prozefautornation GrabH & Co. KG - PROFIBUS DPA
FF H1 CommDTH W1.5 [2003-08-17] . Endrezs+Hauzer, Metso Automation FOT FIELDBUS FF H1
FigldConnes Diagnostic Server W2.1.1.1971 [2003-04-09) - PEPFERL+FUCHS GmbH FD'S Cormmunication
Fetm20 W1.05.09 [2011-07-15) - Endrezs+H auzer HART
HART Communication W1.062 [2015-0317) - Codetrights GmbH HART
IPC [Level, Pressure] Fa193/291 W1.0217 [20014-02-21) 5 Endrezs+H auzer IPC
M=t HART Communication W1.1.0.911 (201 3-03-27) dimSpecific  Endress+Hauser HART
PCP [Readwin] T#U10/F48291  W1.01.18[2014-02-21) - Endress+Hauser PCF
PRk Carnrn _ krin 5 Prafibus DFA
PROFIdtm DFY W2 11[1158] [2010-08-18) . Snftlng Industrial Aulomahon GrbH Prafibus DPAA
SFGMetwark, W1.06.00.235 [215-03-25]  dimSpecific  Endress+H auzer SFGERs

e The new DTM “PRM Comm" is implemented in the Network view.
Network
MNetwork Tag Connection | Channel

& PRM Comm &4 PRM Comm

e Double-click on the DTM “PRM Comm”.
This opens the window “Offline Configuration”.

FRM Comm (Offline Parameterize) x
. PRM Comm S H

7 chneider
Ll Profibus Remate Master Communication DTM LElectric

= General Settings
=] Profibus Master Configuration
..o Basic Settings

L. Advanced Settings

e Select the menu “General Settings”.
o Enter the PRM Gateway MAC address =0:80:F4:FF:2C:29 in this example.
o Enter the PRM Gateway IP address = 10.126.105.33 in this example.

E- f PRM Comm Configuration

~ Factory IP Addi
i f General Settings e i

B Profibus Master Configuration Factory IP Address is derived from the MAC Address printed on the PRM label.

& Basic Settings f f

L. Advanced Settings Factory IP Address:

MAC Address: ID IBDleIFFIZC |29 f 10 .10 . 4 41

This IP Address will be used if the PRM Comm DTM cannot connect to the PRM via the
dedicated IP Address.

—Dedicated IP Address

Dedicated IP Address will be the primary Address used to connect to the PRM. This Address must be previoushy
configured in the PRM Master OTM.

IP Address:
[ 10 128 05 33
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e Select the menu “Basic Settings” and the Profibus address and Baudrate.
Elf PRM Comm Configuration

----- # General Settings € Profibus Basic Settings
E|f Profibus Master Configuration
i # Basic Settings Baud Rate: e E -] oisr
I 'l s

. f Advanced Settings

TS: Profibus Station Address: I 1
HSA: Highest Station Address: I 126

e Save the new settings by clicking on the button “Apply”.

o ][ oes [

Remark:
“Advanced settings” will be updated when the devices are added in the configuration.

5.2 Endresst+Hauser device DTM configuration

e Right-click on the DTM “PRM Comm" and select the menu “Add Device...".

MNetwark

Network Tag | Connection |Channel |Address |Device type (DTM) | Physical Device
Host FC

% Add Device...
% Delete Device
Launch Wizard...
e Select the DTM Micropilot in this example.
P A roew Device
Dievice | ‘Yersion | Class | Manufacturer | Pratocal |

Liquizys M CL # CCM2+3 /7 P& /2,30
|::n:||:||:|t IF ! '-.-'-.-' _IIII_ 22 ZIE='-.-'

e Device DTM is implemented in the Network view.

Network
Network Tag Connection |Channel | Address | Device type (DTM
-5 PRM Comm Ap 1 &# PRM Comm
b S8 Micropilot # FMRSe / PA / PW 1.00.2z / Dev.Rev. 1 Profibus 0 {2 Micropilot / FMRR / PA / FW 1.00.zz / Dev Rev. 1
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e Double-click on the DTM “PRM Comm” to open the “"Offline Parameterize”.

~ . PRM Comm
i Profibus Remote Master Communication DTM

& General Settings
=1 Profibus Master Configuration

...... = Basic Settings

e Select the menu “Profibus Devices”.

=-f# PRM Comm Configuration

- General Settings € Assign Station Addresses to Devices

Version 1.00.00

& Profibus Master Configuration
& Basic Settings

Address | Device Name Vendor

= Advanced Settings

I Type | Version

H o Wicropilot / FMR5x / PA / FW 1.00.zz / Dev.Rev. 1 Endress+Hauser
[=&F, 18 Profibus Devices

0 Micropilot / FMRSx / PA / FW 1.00.zz / Dev.Rev. 1

Micropilot / F. 1.4.0126

4| .

Address (0-128);

e Give the new PROFIBUS address and click on the button “Assign Address”.
In this example, the new PROFIBUS address is 19.

Address (0-126): 1] [

Assign Address ] Directty Applied to the selected device.

¢ New PROFIBUS slave address is updated.

=-[f# PRM Comm Configuration

i.# General Settings 9 Assign Station Addresses to Devices

o Assign Address Directly Applied to the selected device.

EI @ Profibus Master Configuration
: = Basic Settings

Address | Device Name Wendor Type

- Advanced Settings

| Version

2 = 19 Micropilot / FMRSx / P... Endress+Hauser Micropilot / F...
ISR Profibus Devices|

19 Micropilot / FMR5x / PA / FW 1.00.zz / Dev.Rev. 1

Address (0-126):

1.4.0126

|19 Assign Address | Directly Applied to the selected device
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e Select the menu “Advance Settings” and verify the parameter “MAX_TSDR : Largest Station”, which
need to correspond according to the selected Baudrate.

= PRM Comm Configuration
& General Settings
- Profibus Master Configuration
& Basic Settings
-
=-# Profibus Devices
19 Micropilot / FMR5x / PA / PW 1.00.zz / Dev.Rev. 1

0 mmu
TIR (Local): I L3 thits
TTR (Total): || i 965 thits

© Erorn

Token Retry Limit:

Token Error Limit:

RN

= 1.93 ms Message Retry Limit:
Response Error Limit: 5

& oOthers Timings M
GAP: Gap Update Factor: |2 MIN_TSOR: Smallest Station: (R R thits
TSL: Slot time: |20 thits IMAX_TSDR: Largest Station - 100 th'rtsl
TROY: Ready time: (il K2 thits TSET: Setup Time: | | 1 thits
TQUI: Quiet Time: o thits
8 c Timing
Tid*: Time Idle 1: I 37 toits
Tid2: Time ldle 2: 100 thits

e Save the new settings by clicking on the button “Apply”.

[—T—

cmesl [

Apply

5.3 DTM Online mode

e Right-click on the device DTM and select the menu “Connect”.

Network

Network Tag

| Connection |Char1nel |Addre55|Devicetype (DTM)

Host PC
E- %" PRM Comm

¢ PRM Comm
L | Add Device...
it &
% Delete Device
Launch Wizard...

Device type (DTM]) info...

ID Connect
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e (Connected devices
Network Tag

e Double-click on the device DTM “Micropilot /FMR5x/PA/FW 1.00zz/Dev. Rev. 1".
This opens the device DTM window.

Micropilot f FMR 5x [ PA /FW 1,00.zz / Dev.Rev. 1 (Online Parameterize) x

{@®  Device name: FMRS1 Levellinearized: 5  79.3585 %
Device tag: PADD1D Distance {9): S 0.4126 m
|

Status signak ) oo(
@E"g"@llhﬂparamebers ‘% B S % 0 |0

[EI3 1icropiiot 5x
E"-PEI Access status tooling:
([ Setup
[}(d Diagnostics
FHa Expert
0K
Al u | Al .
7 oriee | P M | Diagnostics
¥ comnected | €3 |8 | | |2 | [ | UserRole Planning engineer
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This chapter describes the alternative workflow for commissioning of the Endress+Hauser Plant Asset
Management (PAM system) with independent access path via Fieldgate SFG500. As a result, the
Endress+Hauser PAM system can access underlying PROFIBUS devices for device configuration and asset

health monitoring.

6.1 Fieldgate SFG500 Browser

e Check that the SFG500 is connected to the engineering station network.
e Open the browser and enter the IP address of the SFG500, 10.126.104.253 (specific for this

example).

e ()| B hitp://10.126.104.253

e The Fieldgate SFG500 main window is displayed.

In this view are displayed all detected devices (Masters and slaves) and their corresponding status.

Fieldgate SFG

Endress+Hauser [Z.]

28. Sep 2015 12:39:32 [ 53 Logout

Asset Status

Status

Asset Library

PROFIBUS
= Devices: 24 Q@20 @1 Vi 0o ©o0 @2
#000 Moo1 M002 #003 #004 #005 #006 #007 #008 5009
S010 S011 s012 5013 s014 5015 S016 @ SOMT 5018 S019 @
5020 5021 s022 5023 s024 5025 @ 29
#030 #031 #032 #033 #034 #035
S040 5041 s042 5044 @ 5045
#050 #051 #052 054 #055
#060 #064
#070
#080
#090 04
#10 104
#110 #111 #112 114 16
#120 #121 #122 124 #126
SD01463S/04/EN/01.15
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e (lick on the shortcut “Show list view" to display the connected device types.
In this example the Promag 400 DP flowmeter with the FDL address 45 is displayed.

Fieldgate SFG500 Endress +Hauser (2]

start | Network [I¥T ]| Events | Settings | information 28. Sep 2015 12:42:58 ¥ 5i3 Logout
Status Asset Status
Asset Library —
Devices: 24 @20 ©1 V1 0
Slave w. | NE107 - | Tag Device Type Vendor Ident
5045 DP0O00S Pmmag 400 DP Endress+Hauser 0x1562
5046 DPODO7 Promass 100 DP Endress+Hauser 0x1561

v

Details of Slave: [S045] Promag 400 DP "DP0006 ™
Device Status: OK

A c20s00FF 1562
Not in cyclic data waiting for
details..

6.2 Endress+Hauser DTM SFG500

e Start the application FieldCare.

JFH

FieldCare

e C(reate a new project.
‘FieldCare ==

MHew I Existingl Hecantl

Connection MultiDrop Point-to-Point SOFTING
Wizard
PCP Interface 155 Interface IPC Interface CDI Fa2a CDILSE
National Inst.

Creates an empty project

Open Cancel

SD01463S/04/EN/01.15 91/96



Sclél}%iggf Endress+Hauser (21

Integration Tutorial SEO1 Version 1.00.00

People for Process Automation

¢ Right-click on the Network Tag “Host PC" and select the menu ” Add Device".
MNetwork

[ Delete Device

Launch Wizard...

e Add the device “SFGNetwork”.

=7 Add New Device
Device | Werzion | Clasz | b arwif acturer | Protocol |
CommDTH PROFIBUS DP1 Wa.0.0.9 [2011-01-17) . Trehing & Himstedt Prozefautomation GmbH & Co. KG - PROFIBUS DP4A
FF H1 CommD Tk W1.5[2009-08-17) - Endrezs+Hauzer, Metzo Automation FOT FIELDBUS FF H1
FieldConnes Diaghostic Server W2.1.1.1971 [2008-04-09] - PEPFERL+FUCHS GmbH FOS Communication
Fram20 Y1.05.09 [2011-07-15) . Endress+Hauzer HART
HART Communication W1.062 [2015-0317) . Codetwrights GribH HART
IPC [Lewvel, Pressure] Fa193/251 W1.0217 [2014-02-21) - Endrezs+Hauzer IPC
M HART Comnunication W1.1.0.911 [201303-27] dirSpecific  Endress+Hauzer HART
FCP [Readwin] T=U10/F<4291  %1.01.18 [2014-02-21) - Endress+Hauzer PCP
PR Cornm Wlw dirSpecific  Schneider Electric Prafibus DPA
FROFIdtm DFY1 W 211(115) (2010-08-18) - Softing Industrial Automation GrmbH Prafibus DPA
SFGEMe 10600285 | ] | dtrid ific | Endress+Hauzer

e The new device “SFGNetwork” is then implemented in the Network view.
Network n x
Network Tag Connection | Channel Address | Device type (DTM) | Physical Device

b @SFGNetwork 4 0 [T SFGNetwork

e Right-click on the SFGNetwork device and select the option “Add Device".
Metwark n x
Metwork Tag | Connection |Char1nel |A.ddress |Dem’ce type (DTM) |Physical Device |

EH SFGMNetwork

Delete Device

Launch Wizard...

‘ % Add Device...

e Select the device “SFG500".
7 Add New Device

Device Yersion M anufacturer Fratocol

SFGE5E00 1,06 dimSpecific | Endress+Hauser
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e Double-click on the device “SFG500".

Metwork

Metwork Tag | Connection [Channel | Address | Device type (DTM) | Physical Device
(8] Host PC
- SFGMNetworlk  p. 0 LT SFGNetwork

. @? SFG500 A SFGMNetworkChannel 0 1 SFG500

e The"SFG500" configuration window is displayed.
SFG500 (Configuration) x|

ep—

B
13

Device Name: SFG500

o/m &

Identification: ﬁm

Serial Number: fl—
IP Address: flm]_

Device Tag: f Press [Enter] to accept the new value, ]

PROFIBUS Scan Range:

Start Address: I 0
End Address: I 126

o Configure the IP address according to the network settings. In this example, the IP address

is 10.126.104.253.
Click on the keyboard touch “Enter” to validate the IP address.

Close the window.

e Right-click on the device "SFG500" and select the menu “Create Network".

Network
Network Tag | Connection I[:hannel v |A.ddress IDem’ce type (DTM) |Physical Device
Host PC

E- & SFGNetwork ), 0 £ SFGNetwork

L O C

%ﬂ Add Device...
E__TJ.- Delete Device

Launch Wizard...

Iﬂ_' Create network

e The Endress+Hauser DTM is then displayed in the Network view.
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Right-click on the DTM and select the option “Create Network”. The DTM is then searching all

connected devices.
MNetwork

Networ Tag | Connection |Channel

| Address | Device type (DTM)

| Physical Device

SFGNetworkChannel 1

EH
EH SFG500

% Add Device...
ﬁ _(Pelete Device

Launch Wizard...

E\-, Create network

. |
L Verify network

e Allfound devices are displayed in the Network window.

Metwork

Connection | Channel

4
.. 5 PADODI ap
G PADDDZ 4
5 PADDA 4
5 PADDDS 4
- 2 PADDDE  4p

- PADDID 9
. i PADDTT dp
- GEPADNIZ
- GEPADDIE
-~ ZEDPODOS  4p

SFG500Channel
SFG500Channel
SFGE500Channel
SFGE500Channel
SFGEE00Channel
SFGE500Channel
SFGE500Channel
SFGE500Channel
SFG500Channel
SPG500Channel
SFG500Channel
SFG500Channel
SFG500Channel

| HD2-GTR-4PA

T Cerabar 5 / PMx %/ PA/PW 401 2z / Dev. Rev. 3  Cerabar 5

L Cerabar M / PMehe / PA S FW 1.002z / Dev Rev. 1 Cerabar M &
¥ Deltabar S / xMD 7/ PA S PW 4002z / Dev Rev. 3 Deltabar §

I Promag / 50 / PA / V3.06.x PROMAG 50 PBUS

G Levelflex / FMP &x / PA / FW 1.00.zz / Dev.Rev. 1 Levelflex 3
LEIF Prosonic M / FMU&x / PA / Voo PROSONIC M
LEF Deltapilot M / FMB2x / PA / PW 1.00.zz / Dev.Rev. 1 Deltapilot M 2
21 Micropilot £ FMR&e / PA / PW 1.00.zz / Dev.Rev. 1 Micropilot 5
L Deltabar M/ PMD5¢ / PA/ FW 1.00.zz / Dev.Rev. 1 Deltabar M 5S¢
CEFMTEMP / TMT84 / PA/FW 1.01.2z / Dev Rev. 2 iTEMP TMT24
LT Prowir 200 / A2Bxox / PA / FW 1.00.2z / Dev.Rev. 1 Prowid 200 PA
[ZF Promag 100 / S 1B / DP / FW 1.00.2z / Dev.Rev. 1 Promag 100 DP

e Right click on the Micropilot DTM and select the menu “Connect”.

Metwork Tag I Connection |Char1nel

| Address | Device type (DTM) | Physical Device

Ap SFGE500Channel

..... p SFG500Chanmel 9
----- PADDD1 4 SFG500Charnel 10
- 3
..... ann
52 PADDO2 4 SFG500Charnel 11
----- PADDD4 SFG500Charnel 13
£ A
..... ann
PADDDS 4, SFG500Charnel 14
..... ann
PADDDS 4}, SFG500Charnel 15

S PADDO7 4y SFGE00Channel 16
- 5 PADDD9 g SFG500Channel 18
SFGE500Channel

,_E:] Add Device...

h Delete Device

Launch Wizard...

Device type (DTM) info...

@B’ Connect

T|HD2-GTR-4PA

ETCerabar 5 / PMx 7x / PA/FW 4012z / Dev Rev. 3 Cerabar §
ET Cerabar M / PMx5x / PA/ FW 1.00.zz / Dev.Rev. 1  Cerabar M x
¥ Deltabar S /xMD 7 / PA / PW 4.01.2z / Dev.Rev. 3 Deltabar S

T Promag /50 / PA / W3.060 PROMAG 50 PEUS
T Levelflex / FMP B¢/ PA / FW 1.00.2z / Dev.Rev. 1 Levelflex 5x
LT Prosenic M / FMU4x / PA / Ve PROSONIC M

ZT Dektapilot M / FMBRe / PA / FW 1.00.2z / Dev.Rev. 1 Deltapilot M ¢
EH Micropilot / FMR5c/ PA /PW 1.002z / Dev Rev. 1 Micropilot fx
ET Deltabar M / PMD&c / PA / FW 1.00.zz / Dev.Rev. 1 Deltabar M &x
LEINTEMP / TMT84 / PA /S FW 1.01 2z / Dev Rev. 2 TEMF TMT84
T Prowid 200 / 7<2Bxc / PA/ PW 1.00.2z / Dev Rev. 1 Prowid 200 PA
2T Promag 100 / Bx1Bx / DP / FW 1.00.zz / Dev.Rev. 1 Promag 100 DP
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e The Micropilot is now connected (Online mode).

SFG500Channel | HD2-GTR-4PA

- 558 PADDOT 4 SFGE500Channel ZI Cerabar S / PMx % / PA /S FW 4.01.zz / Dev.Rev. 3

- Sp PADDDZ SFG500Channel g G Cerabar M/ PMxSx / PA / FW 1.00.zz / Dev Rev. 1 Cerabar M ix
- 552 PADDD4 4 SFGE500Channel 13 ZF Deltabar 5 /xMD 7 / PA / FW 4.01.zz / Dev.Rev. 3 Deltabar S

- Zp PADODS SFG500Channel 14 1T Promag / 50 / PA / V3.06xx¢ FPROMAG 50 PBUS
- 558 PADDDE SFGE500Channel 15 G Levelflex / FMP 5/ PA S FW 1002z / Dev Rev. 1 Levelflex B

- Zp PADDDT SFG500Channel 16 1T Prosonic M/ FMUdx / PA / Vi PROSOMIC M
- S PADDDS A SFGE500Channel 18 1T Dettapilot M / FMBSx / PA / PW 1.00.zz / Dev Rev. 1 Deltapilot M 5x
- S PADDTT A SFGE500Channel 20 ZF Delttabar M / PMD&¢ / PA / FW 1.00.zz / Dev.Rev. 1 Deltabar M 5
- 58 PADDI2 SFG500Channel 21 CIFTEMP / TMT84 / PA/ FW 1.01.zz / Dev.Rev. 2 iTEMP TMT24
- S PADDTE A SFGE500Channel 25 G Prowir 200 / PxZBoc / PA S FW 1.00.zz / Dev.Rev. 1 Prowid 200 PA
- 5 DPO00S SFGE500Channel 44 L Promag 100 / Sx1Bxc / DP / FW 1.00.zz / Dev.Rev. 1 Promag 100 DP

e Double-click on the Micropilot.. The online parameters are displayed.

PADDI0 (Online Parameterize) €

@®  Device name: FMRS1 Level linearized: [  79.3534 %
Device tag: PAOD1D Distance (9 Gg  0.4129 m

Status signak: ) DK
@ S| A perameters H#FDEF 3% 00

Access status tooling:
Setup

Diagnostics

Expert

2

< I J <] il
2 Online J oM ‘ Diagnostics
% Connected | S | i | | | ﬁ | (] ‘ User Role: Planning engineer
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www.endress.com/open-integration

SD01463S/04/EN/01.15 96/96


http://www.endress.com/

